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Resumen

Actualmente existen diversas enfermedades degenerativas, como la Esclerosis
Lateral Amiotréfica (ELA), la cual es una enfermedad que ataca a las neuronas
encargadas del control de los movimientos del cuerpo, como resultado de esta
enfermedad la persona que la padece no puede mover ninguna parte del cuerpo,
por ello usan una silla de ruedas, lo que los convierte en personas dependientes

para trasladarse de un lugar a otro.

Teniendo en cuenta que los pacientes de Esclerosis Lateral Amiotréfica no
pierden su capacidad cerebral, se plantea el desarrollo de una interfaz cerebro-
computador, la cual se encarga del procesamiento y clasificacion de ondas
cerebrales para controlar su silla de ruedas; usando Matlab y OpenBCI que
consta de 16 electrodos que se ubican en la cabeza del usuario, el cual imaginara
el movimiento de los brazos, para que el algoritmo sea capaz de interpretar las

sefales, con las cueles se puede mover su silla de ruedas.

En esta tesis se logra la comunicacién cerebro-computador, el cual nos permite
captar las sefales provenientes del cerebro, concernientes a la imaginacion del
movimiento de los brazos; estas sefales pasan por la transformada de Fourier,
para identificar las sefnales donde se presenten diferencias notorias, con las
cuales se logra controlar un prototipo de silla de ruedas, de esta manera se le
brinda al paciente independencia parcial; ya que, puede controlar su silla de
ruedas por sus propios medios de esta manera se influye indirectamente en

mejorar su calidad de vida.

Palabras claves: OpenBCl, Matlab, interfaz cerebro-computador, EEG,
electroencefalograma, Esclerosis Lateral Amiotréfica, ELA, Ondas Cerebrales,
Sistema de Comunicacion, Caracteristicas de l|la Sefiales Cerebrales,

Transformada de Fourier.



Abstract

There are various degenerative diseases, such as Amyotrophic Lateral Sclerosis
(ALS), which is a disease that attacks the liable neurons for controlling body
movements, as a result of this disease the person suffering from it can’t move
any part of the body, so they use a wheelchair, which makes them dependent

people to move from one place to another.

Taking in mind that patients with Amyotrophic Lateral Sclerosis do not lose their
brain capacity, the development of a brain-computer interface is proposed, which
is responsible for the processing and classification of brain waves, to control their
wheelchair, using Matlab and OpenBCI It consists of 16 electrodes that are
located in the user's head, which will imagine the movement of the arms so that

the algorithm can interpret the signals, with which you can move your wheelchair.

In this thesis the brain-computer communication is achieved, which allows us to
capture the signals from the brain, concerning the imagination of the movement
of the arms, these signals pass through the Fourier transform, to identify the
signals where there are notable differences, with which it is possible to control a
prototype wheelchair, in this way the patient is given partial independence, since
he can control his wheelchair by his means, in this way he indirectly influences in

improving his quality of life.

Keywords: OpenBCl, Matlab, brain-computer interface, EEG,
electroencephalogram, Amyotrophic Lateral Sclerosis, ALS, Brain Waves,

Communication System, Characteristics of Brain Signals, Fourier Transform.
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Introduccién

El presente proyecto es un sistema que ayudara a las personas con esclerosis
lateral amiotréfica o enfermedad de las neuronas motoras; El Ministerio de Salud
(MINSA) clasifica las enfermedades en categorias, una de ellas es la categoria
“ATROFIA MUSCULAR ESPINAL Y SINDROMES AFINES”, en esta categoria

existen 5 sub categorias que son las siguientes:

- Atrofia muscular espinal infantil, tipo | (werdnig — Hoffman).
- Oftras atrofias musculares espinales hereditarias.

- Enfermedades de las neuronas motoras.

- Otras atrofias musculares espinales y sindromes afines.

- Atrofia muscular espinal, sin otra especificacion

Todas las enfermedades mencionadas provocan una discapacidad, la cual las
obliga al uso de una silla de ruedas; el sistema que se plantea ayudara a que las
personas ya puedan trasladarse por sus propios medios; ya que podran controlar

su silla de ruedas con las sefales de sus cerebros.

Se plantea un disefio de una interfaz cerebro-maquina, utilizando algoritmos para
la clasificacion de las sefiales electroencefalograficas, lo cual permite que el
sistema tenga cierta inteligencia para clasificar las sefales y por ende una mayor

precision al ejecutar las ordenes.

Este proyecto sera implementado en un prototipo a escala, lo cual nos permitira
tener mayor conocimiento acerca del tipo de tecnologias a usar; ademas de las

ventajas que posee el sistema y las mejoras futuras que se le podria realizar.

El capitulo | encontraremos el planteamiento del problema, objetivos alcances y
limitaciones; en el capitulo Il corresponde al fundamento tedrico, donde
encontraremos los antecedentes y el marco tedrico; en el capitulo Il
encontramos el desarrollo de todos los objetivos y finalmente; en el capitulo IV

encontramos todo el analisis econdmico de esta tesis.



CAPITULO I: PLANTEAMIENTO Y FORMULACION
DEL PROBLEMA



1.1.

1.1.1.

1.1.2.

1.1.3.

DEFINICION DEL PROBLEMA DE INVESTIGACION

Planteamiento y descripcién del problema

Una de las enfermedades que degeneran las neuronas es la esclerosis
lateral amiotréfica (ELA), la cual afecta al sistema nervioso central, lo que
conlleva a una paralisis general de manera progresiva; por lo que, tiene
un pronostico mortal. Segun el Ministerio de Salud del Peru (MINSA) la
cantidad de personas con ELA, en todo el territorio peruano es de 337 con
mayor incidencia en Lima, la cual representa el 63% de los casos; el ELA
en el Peru afecta principalmente a personas con una edad entre 30 y 59
afnos, los cuales representan el 49% de los casos a nivel nacional.

El problema de los pacientes que padecen de esclerosos lateral
amiotrofica es que con el paso del tiempo necesitan que terceras personas
los ayuden a desplazarse, volviéndose dependientes; esta condicion los
obliga a usar una silla de ruedas; caso contrario, se vera disminuida la
calidad de vida del paciente; ya que se sentira frustrado al no poder
desplazarse por su cuenta.

Para evitar la dependencia, se puede usar las sefiales cerebrales del
paciente con la finalidad de disefar una interfaz cerebro-maquina que le
permita sentirse con mayor libertad; ya que podra desplazarse por sus
propios medios, mejorando su calidad de vida y aportando parcialmente a
su independencia. Cabe mencionar que el paciente de ELA no pierde su
capacidad cerebral en el transcurso de la enfermedad; ya que esta, solo

afecta a las partes que les brindan movimiento a los musculos.

Formulaciéon del problema general

¢, Coémo lograr que los pacientes con ELA puedan controlar su silla de

ruedas usando su cerebro, el cual es completamente funcional?

Formulacion de los problemas especificos
P.E.1: ;Cual es la situacion actual de los pacientes con ELA?
P.E.2: ;Cuales son los parametros y caracteristicas necesarias para la

implementacion de una interfaz cerebro-maquina?



1.2.

1.21.

1.2.2,

1.3.

P.E.3: ;Como diferenciar o interpretar las sefales de la actividad
cerebral?
P.E.4: ; Como probar el funcionamiento de la interfaz cerebro-maquina?

P.E.5: ; Como validar el funcionamiento del sistema?

DEFINICION DE LOS OBJETIVOS DE LA INVESTIGACION

Objetivo general

Implementar una interfaz cerebro-maquina para controlar una silla de
ruedas a través del procesamiento y clasificacion de sefales
electroencefalograficas usando algoritmos y las herramientas de Matlab;
de tal forma que le permita a un paciente de ELA tener independencia

parcial al trasladarse con su silla de ruedas.

Objetivos especificos

O.E.1: Analizar la situacién actual de los pacientes con ELA.

0.E.2: Conocer los requerimientos técnicos necesarios para el
desarrollo de una interfaz cerebro-maquina.

O.E.3: Procesar las senales electroencefalograficas.

0.E.4: Disenar un prototipo de silla de ruedas a escala.

O.E.5: Implementar y probar el sistema de comunicacion y control.

JUSTIFICACION DE LA INVESTIGACION

Actualmente; hay muchos estudios con base en las sefales del cerebro,
la gran mayoria enfocados a enfermedades, tanto en leves como en
mortales. Muchos pacientes tratan de seguir adelante; sin embargo, la
sociedad muchas veces los margina; esto genera que los pacientes se

aislen, conllevando a problemas como la depresion.

Con este trabajo se busca ayudar a los pacientes con enfermedades
mortales como el ELA ademas indirectamente a las personas que tienen
alguna discapacidad motora que los conlleve al uso de una silla de ruedas;

con este proyecto los ayudamos a movilizase con mayor facilidad por sus



1.4.
1.41.

1.4.2,

propios medios, de esta forma los dotamos de independencia parcial y

mejoramos su calidad de vida.

ALCANCES Y LIMITACIONES DE LA INVESTIGACION

Alcances

El presente proyecto tiene un alcance que abarca a todas aquellas
personas que poseen alguna discapacidad fisica, la cual los obliga a

transportarse en silla de ruedas.

Este proyecto alcanzara el nivel de implementacion de la interfaz cerebro
computador, y un prototipo de silla de ruedas a escala, para demostrar el

funcionamiento de la interfaz cerebro computador.

Limitaciones

El acceso a la informacion es limitado debido a que se encuentra en otros
idiomas.

Es complicado acceder a pacientes con ELA, ya que son muy pocos los
que poseen esta enfermedad; y ademas sus familiares son muy

reservados, por lo que no permiten que se le realice pruebas al paciente.



CAPITULO Ill: FUNDAMENTO TEORICO



21.

21.1.

ANTECEDENTES

Internacionales

Del trabajo realizo por Abaitua (2012), se menciona que, dentro de las
propiedades eléctricas del cerebro se puede localizar los potenciales
evocados P300, los cuales se presentan cuando hay inesperados
estimulos visuales. Las senales mencionadas fueron el punto de partida
del proyecto citado, con las cuales el autor busco realizar un disefio de un
decodificador de caracteres, orientado a las personas que poseen alguna
incapacidad para comunicarse. El sistema de software empleado en el
trabajo es el Visual P300 speller, el cual permite lograr evocar, en el sujeto
de estudio, los potenciales P300 atreves de una interfaz grafica, ademas

permite grabar el electroencefalograma del sujeto de estudio.

Se concluye que a lo largo del proyecto se logré desarrollar una matriz de
letras, de la cual el paciente puede transmitir la letra que desee con solo
fijar su atencion en ella, esto se logré mediante el uso de un decisor MAP,

el cual es capaz de predecir la letra que el sujeto desea comunicar.

Del trabajo realizado por Guevara Mosquera (2012), se puede mencionar
que lo que se busca a hacer uso de sistemas es ayudar al ser humano ,
particularmente, en el analisis de sefiales cerebrales para poder realizar
aplicaciones de inclusion social. Es por ello que se ha realizado un
prototipo de silla de ruedas, la cual recibe sefales de la actividad cerebral

del usuario.

Se concluye que se logré entender que el estado de animo y de
concentracion de los usuarios es de gran importancia al momento de
poner en funcionamiento a la silla de ruedas; ya que produce que las
sefales varien, se recomienda que el usuario haya dormido bien, y que
este bien relajado. Se logré que el sistema responda de manera rapida a
los requerimientos del usuario, teniendo la posibilidad de entregar

diferentes ordenes; esto se logra gracias a que la programacién en la



2.1.2.

plataforma LabVIEW, no se manejé muchos bucles, ya que provocan que

el sistema sea lento.

Finalmente; en el trabajo de lturrate, Escolano, Antelis, & Minguez (2009),
en este trabajo se describen dos dispositivos de rehabilitacion, que son
un robot y una silla de ruedas y ambos controlados con el pensamiento,
con la finalidad de realizar tareas de teleoperacion de manera remota, en
al caso de la silla de ruedas las sefales EEG son procesadas y enviadas
hacia al sistema de navegacion, el cual se encarga de la conducciéon de

la silla de ruedas hasta el lugar indicado.

Se concluye que con la implementacién de una silla de ruedas controlada
por sefales cerebrales, esta silla de ruedas cuenta con un interfaz
cerebro-ordenador, con potenciales evocados P300 sincronizados,
ademas de poseer un sistema de navegacion, lo cual genera mayor
rendimiento del sistema, el proyecto fue usado y validado por cinco

usuarios sanos tanto para la silla de ruedas como para el brazo robético.

Nacionales

El trabajo de Roman Gonzalez (2010), nos dice que es posible disenar
sistema BCI enfocado en pacientes que sufren pérdidas de funciones
motoras para que puedan controlar e interactuar con su entorno, a traves
de la adquisicion de sefiales electroencefalograficas, ademas de un
algoritmo para extraer las sehales del cerebro y de un método para

clasificarlas.

Se concluye que se ha logrado la construccidon de un sistema capaz de
mover un curso sobre la pantalla de un computador a partir de la actividad
cerebral al momento de imaginar movimientos de la mano derecha e
izquierda, ademas nos recomienda realizar un entrenamiento previo, con
un minimo de 60 pruebas, con cada paciente ya que tienen una actividad

cerebral distinta.
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2.21.

El trabajo realizado por Achic Alarcon (2016) tiene por finalidad disefiar
un sistema capaz de controlar un brazo robo6tico montado en una silla de
ruedas, la cual también es automatizada; el control fue por medio de
sefales EEG, basado en el procesamiento de sefiales cerebrales
producto de estimulos visuales con los que se podra definir comandos de

movimientos basicos; con el objetivo de reducir fatigas mentales.

Se concluye que gracias a los resultados de las pruebas, fue posible
implementar una interfaz para la seleccién de comandos, el cual tiene un
grado de aciertos promedio de 79 %; ademas se logré definir criterios para

el acoplamiento entre la silla y el robot.

Finalmente, en el trabajo de Diaz Sotelo, Joya, Ron, & Garcia Lagos
(2016), en el cual se clasifica patrones correspondientes a dos tareas
mentales, obtenidos mediante un sistema BCIl. Para ello se utilizé el
paradigma neuronal de los Mapas Autorganizativos de Kohonen (SOM,
por Self-Organizing Maps). Los patrones utilizados se obtuvieron

aplicando la Transformada Rapida de Fourier a las senales EEG.

Se concluye que luego de la seleccidn de la red con mejor rendimiento y
de su entrenamiento respectivo, se ha logrado un porcentaje de error

comprendido entre 6.25% y 3.75% en la clasificacion de tareas.

MARCO TEORICO

Esclerosis lateral amiotroéfica

Como se menciona en Alvarado-Diaz, Meneses-Claudio, & Roman-
Gonzalez (2017), el neurdélogo Martin Gavidia de la clinica anglo
americana menciona que ELA es la enfermedad mas incapacitante, que
produce consecutivos y diversos dafos en el ser humano; un paciente con
ELA posee diferentes dificultades conforme al avance de la enfermedad,
una de ellas es la postracién del paciente, para lo cual necesitara usar una
silla de ruedas ademas de necesitar una persona que lo traslade; por el

mismo hecho de estar postrado, se pueden producir ulceras de decubito



que son heridas que se forman por el contacto prolongado de la piel con
superficies duras; otra complicacion es la aspiracion de alimentos, con el
cual, sino se tiene el cuidado necesario puede producir asfixia, es por ello
que el paciente requerira de personal adecuado para su cuidado; la
pérdida de peso es inherente a la enfermedad; ya que se recomienda
llevar una dieta especial; finalmente, la neumonia que es la inflamacion

de los pulmones

Alvarado-Diaz et al. (2017), menciona que el neurdlogo Carlos Castarfieda
de la clinica el golf, menciona que el funcionamiento normal del sistema
nervioso inicia en el cerebro con impulsos que se trasladan de una
neurona a otra; cuando el ELA agrede a este sistema, el cuerpo produce
una inflamacién, como sistema de defensa, la cual se ve alterada con la
enfermedad, de esta manera el ELA consigue dafiar los axones de las
neuronas e incluso la corteza, es por ello que el ELA es una enfermedad
autoinmune. ELA se caracteriza por daiar la sustancia blanca del cerebro,
que es donde se encuentran todas las conexiones, lo cual produce la
perdia de funciones que dependen del cerebro o la medula espinal.
Menciona también que el ELA es una enfermedad multifactorial, ya que,
se debe tomar en cuenta multiples factores como: carga genética (no
demostrada), infecciones virales, vacunas (activan el sistema inmune),
cirugia, estrés, traumatismos, entre otros; la mayoria de pacientes tienen

al menos un factor, de los ya mencionados en comun
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Figura 1. Comparacién de una neurona normal y una afectada.

Fuente: ALS association.

A. Sintomas

Segun los neurdlogos antes mencionados los sintomas de la enfermedad

pueden ser:

Calambres; ademas de la posibilidad de ser un sintoma puede
acompanar a la enfermedad, ya que los musculos, inician la produccién
de estimulos anémalos, producto de las enervaciones de la via motora,
asi produciéndose calambres en lugares inusuales por ejemplo en el
abdomen, cara, brazos, lo cual significaria un sintoma del inicio de la
enfermedad.

Ahogo; en pacientes con ELA moderado-avanzado se da por la dificultad
de movilizar la caja toracica, lo cual generara una sensaciéon de falta de
aire ademas de la incorrecta movilizacion de los pulmones, lo cual genera
una deficiencia en la movilizacién de secreciones, produciéndose asi la
sensacion de ahogo o falta de aire.

Habla; los pacientes con ELA tienen problemas con la articulacion del
lenguaje, generalmente se da cuando la enfermedad inicia a nivel bulbar
o cuando ya hay un avance al nivel mencionado.

Fatiga; sin razén alguna se produce cansancio con lo cual el paciente se

debilita y no tiene fuerzas para realizar actividades fisicas.
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e Vision doble; este sintoma esta relacionado a lesiones en el area
occipital del cerebro o en el tronco encefalico

e Perdida del equilibrio; se relaciona a dafos en el cerebelo lo cual genera
trastornos de equilibrio y coordinacion.

¢ Hormigueos; se da cuando hay dafios en la zona parietal del cerebro lo
que se expresa con el adormecimiento de una parte del cuerpo.

e Dolor facial; se puede considerar un sintoma comun ya que lo padece
aproximadamente el 50% de los pacientes.

e Espasmos; es la rigidez debido a la agresién motora que produce
cambios en el tono muscular, lo cual suele ser doloroso.

¢ Incontinencia urinaria y/o fecal; se produce por la pérdida del control de
esfinteres.

Para un diagndstico acertado los sintomas mencionados deben ser consistentes

y duraderos, ademas de acentuarse con el paso del tiempo.

2.2.2. Electroencefalograma

El electroencefalograma (EEG), es el registro eléctrico de la actividad
cerebral desde la superficie craneal, estas sefales cerebrales varian entre
1 y 50Hz ademas de una amplitud de 20 — 100 micro voltios. (Roman
Gonzalez, 2010), (Diaz Sotelo et al., 2016) , (Cordova Villar, Perez
Oviedo, & Roman Gonzalez, 2013) y (Alvarado-Diaz et al., 2017)

En el proyecto de Diaz Sotelo et al. (2016) se menciona que el
electroencefalograma se obtiene por medio de electrodos; debido al gran
numero de interconexiones neuronales las sefiales poseen una forma
compleja, que varia con la localizacién de los electrodos ademas de variar
de un individuo a otro. Para una colocacién correcta de los electrodos se
debe seguir el sistema internacional 10/20, el que podemos ver en la figura
2.
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Figura 2. Posicionamiento de electrodos, sistema 10/20.

Talamillo Garcia (2011), nos menciona que para la colocacion de
electrodos se debe conocer la diferencia entre, derivacion y montaje de
electrodos. Una derivacion la conforman dos electrodos conectados a una
canal del sistema de amplificacion; y un montaje es aquel en el cual se
usan un conjunto de derivaciones, pero en este caso tenemos dos tipos
de montajes, los bipolares que son el registro de la diferencia de potencia
entre dos electrodos; el montaje monopolar se registra la sefial de un

electrodo y una referencia, que puede ser comun para varios electrodos.

A. Ritmos basicos

Segun Martinez (2009) los ritmos basicos tomado en cuenta la frecuencia se

pueden identificar los siguientes : Delta, Theta, Alfa, Beta, Gamma.

RITMO DELTA

Segun Morillo (2011) La actividad delta es dificil de registrar, en personas
despiertas, pero si es posible capturar la actividad lenta posterior que se
mezcla con actividad alfa, esta alcanza una amplitud moderada y tiene
una frecuencia alrededor de los 1.5 a 3 Hz, lograndose alcanzar
amplitudes mayores en los cuadrantes posteriores. Existen grados

variables del predominio de la actividad delta, en casos donde el suefio
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es profundo, los mismos que permiten diferenciar y cuantificar las sefiales
durante el sueno.

Segun Kassim, Ibrahim, Buniyamin, & Murat (2012) este tipo de ondas
cerebrales se manifiesta cuando la persona se encuentra en un estado de

suefio profundo.

RITMO THETA

En Morillo (2011), se menciona que la actividad theta se compone
morfolégicamente por diversas ondas, que suelen ser regulares o
irregulares ademas de tener una escasa duracion, estas sefales trabajan
a una frecuencia de 4 a 8 Hz, y suelen ser de amplitud baja, ademas se
distribuyen en las regiones temporales del cerebro. La actividad theta se
puede apreciar con mayor intensidad a medida que las personas
envejecen; debido a que su origen y significado no es claro, se considera
que probablemente representen un componente de retardo, que forma
parte de una respuesta de un potencia evocado mediante el alertamiento;
generalmente se encuentran como ondas lentas en zonas posteriores,
estas sefales se pueden encontrar: durante un estado de vigilia, al mover
los ojos para realizar busquedas, al observar los elementos presentes en
un dibujo, etc. En los estados mencionados, en las regiones occipitales
aparecen deflexiones denominadas ondas lambda, las cuales tiene una
amplitud menor a 50 yV, y siempre aparecen de manera sincronizada en

los dos hemisferios.

Segun Kassim et al. (2012) esta forma de onda se manifiesta cuando una

persona esta cansada o en un estado de depresion.

RITMO ALFA

Morillo (2011), menciona que la actividad alfa hace referencia a
actividades electroencefalograficas que oscilan entre los 8 y 13 Hz de
frecuencia en adultos normales, se presenta en regiones posteriores
durante la vigilia, con ojos cerrados y relajado, esta sefal se atenua o

bloquea con los ojos abiertos. Esta compuesto por ondas monomorfas,
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con similitudes entre todas, ademas poseen aspecto fusiforme o

sinusoidal, La amplitud de estas sefales varian entre 20 y 60 pV.

Segun Kassim et al. (2012) esta forma de onda se manifiesta cuando una
persona esta despierta y relajada, ademas comunmente se asocia a esta

onda cerebral con el rapido aprendizaje.

e RITMO BETA

En Morillo (2011), menciona que el ritmo beta esta definido basicamente
por su frecuencia, la cual es mayor a 13 Hz, en general de 18 a 25 Hz, y
en actividad mayor a 30 Hz, este tipo se sefial posee una amplitud muy
pequefia, es por ello que es complicado registrarla con técnicas
convencionales. Su amplitud usualmente varia entre 5y 10 pV, en casos
anormales supera los 30 uV. El significado de esta sefial no es claro, pero
se evidencia que su presencia depende del normal funcionamiento del

cerebro.

Segun Kassim et al. (2012), esta onda cerebral se relaciona a una persona

despierta y en estado de alerta.

A manera de resumen en la tabla 1 podemos ver las sefiales con su

respectiva simbologia ademas de sus voltajes y su frecuencia.

Tabla 1. Tabla de ritmos de las senales del cerebro.

Nombre Simbolo  Voltaje (uv) Frecuencia (HZ)

Delta A 70— 100 <4
Theta T 50 4-8
Alfa A 20-60 8-13
Beta B 10-15 13-30
Gamma r 2 30-35

2.2.3. Interfaz cerebro-maquina

Cardinali (2009), expone que de forma natural el cerebro se comunica a

través de un proceso que comienza con la intencion del usuario, el cual
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2.2.4.

genera una actividad en diferentes areas del cerebro, las cuales son
enviadas a través el sistema nervioso periférico. Un sistema cerebro-
maquina es un sistema artificial en el cual las sefiales ademas de las vias
normales pasan por otras vias de comunicacién hacia un computador, el
cual se encarga del control correspondientes de sistemas electrénicos. Un
modelo esquematico genérico de una interfaz cerebro-maquina se puede

ver en la Figura 3.

RETROALIMENTACION

ADQUISICION DE LA APLICACION
SENAL EEG

Figura 3. Esquema genérico de una interfaz cerebro-maquina.

Cyton board
En OpenBCl (2016), mencionan que la Cyton Board (figura 4) es una

herramienta open source que conforma un conjunto de elementos y
biosensores, que se pueden utilizar para probar la actividad del cerebro
(EEG), la actividad muscular (EMG), y la actividad del corazon (ECG). El
sistema tiene una comunicacion inalambrica a un ordenador a través de
la OpenBCl dongle (USB programable), ademas tiene la capacidad de
comunicarse de forma inalambrica a cualquier dispositivo movil o tableta

compatible con Bluetooth Low Energy (BLE).

16
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Figura 4. Sistema Cyton Board de Open BCI.
Fuente: Open BCI.

2.2.5. Matlab

MathWorks (2017), menciona que Matlab es un software con bases
matematicas y posee un entorno de desarrollo integrado (IDE), ademas
de un lenguaje propio, denominado lenguaje M. Este software posee
toolboxes que son bloques de programa ya definidos y especializados en
un area especifica. Estas herramientas nos dan la posibilidad de explorar
datos simultaneos lo cual permite realizar mas evaluaciones en un tiempo

reducido.

Search Documentation

E &L New Variabls

L Open variable ~ SIMLILINK | ENVIRONMENT | RESOURGES |
- - -
= 5 E L v C v ProgramFiles » MATLAB » R2016a » bin » ~|p
Current Folder ®@  [EeelnnERRUT Lol UGN Workspace @
[ Name ~ fx >> | Name = Value
m3iregistry A
registry
util
winbd
deploytool.... « s
iniciar.m
=] lcdataseml Command History ®
|| ledatauxsd guide A
@ ledata tfa Y 7 _
= 3x untitled
Details ~ el v

P11
-

Figura 5. Entorno grafico de Matlab.
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2.3.

2.3.1.

2.3.2.

2.4,

2.4.1.

MARCO METODOLOGICO

Tipo de investigacion

El presente proyecto tiene un enfoque de investigacion aplicada, ya que
al nivel de implementacion se pude demostrar la tecnologia usada
ademas del nivel de aplicacion y usabilidad que posee el sistema, el cual
esta compuesto por el sistema OpenBCl, el cual se utilizara para que
interactue directamente con el paciente con ELA y con la PC que
procesara y clasificara las sefiales cerebrales gracias a algoritmos

programados en Matlab con lo cual se lograra controlar la silla de ruedas.

Metodologia de la investigacion

Metodologia de la investigacion para el presente trabajo inicia con la
busqueda de informacién bibliografica que guarden relacion con el tema
presentado, con la finalidad de obtener informacion adecuada sobre el
avance de la tecnologia relacionada con las ondas cerebrales ademas del
conocimiento de los parametros esenciales para el funcionamiento del
sistema presentado. Se utiliza el dispositivo OpenBCI debido a que es
muy apropiado para la lectura de ondas cerebrales, asi como también de

otras senales corporales.

Luego de tener toda la bibliografia, es suficiente probar el sistema con
personas sanas para demostrar su correcto funcionamiento. Este paso es

importante ya que podremos obtener e identificar las ondas cerebrales.

Finalmente, en la PC provista de un algoritmo creado en MATLAB, con el
cual clasificara las sefiales, se procedera darles el significado adecuado,

con la finalidad de poder orientar el movimiento de la silla de ruedas.

MARCO LEGAL

Ley General de la Persona con Discapacidad (Ley N° 27050)

En (Congreso De La Republica Del Peru, 1998). Donde se genera la Ley
General de la Persona con Discapacidad (Ley N° 27050), en esta ley se

genera la creacion del Consejo Nacional para la Integraciéon de la Persona
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con Discapacidad (CONADIS) y lo se incorpora al Ministerio de la Mujer y

poblaciones vulnerables (MIMP). Esta ley nos menciona:

Articulo 11.- nos menciona que el Ministerios de Salud, ministerio de
Defensa, ministerio del Interior, y el Instituto Peruano de Seguridad Social,
son autoridades legales a las que les compete declarar la condicion de
persona con discapacidad, atreves de sus centros de salud, ademas de

otorgar el certificado que lo acredite.

Articulo 16.- toda persona con discapacidad tiene derecho al acceso a
los servicios de salud. Ademas, se les debe brindar una atencion especial,

que faciliten su asistencia y tratamiento.

Articulo 33.- Tanto como el CONADIS y el Ministerio de Trabajo y
Promocién Social, apoyaran y fomentaran el empleo, ademas de los

programas especiales, orientados a personas con discapacidad.

Articulo 43.- El Ministerio de Transportes y Comunicaciones y las
Municipalidades, son los encargados de la progresiva restructuracion del
disefio urbano, dotandola de elementos adecuados para el uso y facil
desplazamiento de las personas con discapacidad, en el cumplimiento de
la Resolucion Ministerial N° 1379-78-VC-3500.

Articulo 44.- Toda infraestructura de uso comunitario, publico y privado,
debera estar dotada de accesos, ambientes o corredores de circulacion e

instalaciones adecuadas para personas con discapacidad.

Articulo 45.- EI CONADIS junto con el Ministerio de Transportes y
Comunicaciones y las Municipalidades, trabajaran con el fin de que en los
vehiculos de transporte publico se reserven asientos preferenciales

cercanos y accesibles.

Articulo 46.- Las Municipalidades deberan disponer ubicaciones
preferenciales en cada parqueo publico para vehiculos conducidos o que
transporten personas con discapacidad. EI CONADIS es el encargado de
supervisar el cumplimiento de esta disposicion y fijara las multas a los

infractores.
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24.2. Ley Que Declara De Interés Nacional Y Preferente Atencién El
Tratamiento De Personas Que Padecen Enfermedades Raras O
Huérfanas (Ley N° 29698)

Esta ley N° 29698 creada con el MINSA (Ministerio de Salud en el afio
2013 debido a la gran proliferacion de nuevas enfermedades
desconocidas; la finalidad de esta ley es la prevencion, el diagnéstico, la
atencion integral de salud y rehabilitacién de pacientes con enfermedades

raras. (Congreso de La Republica del Peru, 2011)

El Ministerio de Salud mediante esta ley planea el diagndstico y atencién
inmediata a pacientes con enfermedades raras, en base a eso, ha
planteado que se actualicen y/o agreguen informaciéon sobre estas
enfermedades a la educaciéon de los estudiantes de instituciones
educativas o universitarias y al cuerpo médico. Por lo tanto, se requiere el
registro de pacientes que padecen de éstas enfermedades para generar
informacion sobre este tipo de enfermedades como, por ejemplo: su indice
de mortalidad, la prevalencia, la incidencia, el area geografica en donde

es comun, etc. (Congreso de La Republica del Peru, 2011)

El MINSA ha optado mediante esta ley las medidas necesarias para la
obtencion de medicamentos para la atencion de pacientes que sufren
enfermedades raras. Ademas, tienen planeado en una prevision
presupuestaria en donde, segun las leyes anuales de presupuesto
presentan que el gasto principal es para la prevencion, diagnostico, el
tratamiento, los medicamentos y la atencion integral de salud de estas
personas que sufren enfermedades raras.(Congreso de La Republica del
Peru, 2011)

Esta ley esta enfocada a la inclusion social y al derecho universal a la
salud para personas que padecen enfermedades raras o huérfanas,
ademas de la prevencion de nuevos casos. Gestionar la atenciéon de
pacientes mediante la creacion de la Red Integrada de Servicios para
Enfermedades Raras o Huérfanas para ayudar y capacitar a profesionales

de la salud.
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243. Ley de los productos farmacéuticos, dispositivos médicos y

productos sanitarios (Ley N° 29459)

En esta ley se establece los principios, criterios y exigencias sobre los
productos farmaceéuticos, dispositivos médicos y productos sanitarios, de
uso en seres humanos. (Congreso de La Republica del Peru, 2009). En el
articulo 2 de la presente norma se establece el ambito de aplicacién de la
misma donde menciona que, los productos farmacéuticos, dispositivos
médicos y productos sanitarios son aplicados de manera preventiva,

diagnostica, de tratamiento y otros.

En el articulo 8 del capitulo IV de la Ley N° 29459 se establece que todos
los articulos dentro de su clasificacion requieren de registro sanitario, lo
cual faculta a su titular para la fabricacién, la importacion,
almacenamiento, comercializacion de dichos productos, el registro

sanitario se da de manera temporal y es renovable cada 5 afnos.

En el capitulo XIV se mencionan las normas especiales para dispositivos
meédicos, donde mencionan que la calidad de los dispositivos médicos lo
definen sus caracteristicas inherentes, las cuales cumplan con los
requisitos o estandar previstos por la direccién general de medicamentos

insumos y drogas (DIGEMID).

Finalmente, en la norma nos muestra las medidas de seguridad e
infracciones y sanciones, en donde menciona que los principios basicos
son la proteccion de la salud y la vida de las personas; ser aplicadas con
objetividad, imparcialidad e independencia y ser proporcionales a los fines
que se persiguen; las medidas de seguridad deben ser, la inmovilizacion,
incautacion, aislamiento, retiro, destruccion, suspension, cancelacion,
cierre, emision, segun corresponda e caso, las sanciones pueden ser:
amonestaciones, inhabilitacion, multa, cancelacion, suspension, cierre y

decomiso, segun corresponda.
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CAPITULO lll: DESARROLLO
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3.1.

3.1.1.

3.1.2.

ANALISIS DE LA SITUACION ACTUAL

ELA Tiene una incidencia de 1 a 3 casos por cada 100000 personas, con
una mayor frecuencia en hombres de entre 20 y 80 afos. (Graimann,
Allison, & Pfurtscheller, 2010)

ELA en el mundo

El trabajo es el de proporcionar una comunidad internacional de
asociaciones en todo el mundo, fue fundada en 1992 y su visién es
participar con sus miembros, y otras organizaciones para compartir
recursos a nivel mundial, promover la conciencia y apoyar a las personas
con ELA / MND (Amyotrophic Lateral Sclerosis and Motor Neurone
Disease) en todo el mundo. Su funcion principal es intercambiar
informacion sobre la enfermedad, incluyendo la investigacion y la gestion
de la atencién. También proporciona apoyo a las asociaciones miembros
a través de la creacion de redes para el intercambio de ideas sobre las
buenas practicas, hoy en dia, mas de 35 paises se han unido a este grupo.
Esta asociacion colabora con la Asociacion MND de Inglaterra, Gales e
Irlanda del Norte en el Simposio Internacional sobre ALS / MND cada ano.
(“International Alliance of ALS/MND Associations —,” 2009)

A4S
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y ALLIANCE OF
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\‘&w}/[ ASSOCIATIONS

Figura 6. Asociacion internacional de ALS/MND.

Fuente: Asociacion internacional de ALS/MND
ELA en el Peru
En el Peru existe una organizacién Asociacion ELA Peru. Fundada por
Edwin Alcazar; ELA Peru nace de la unién de un grupo de familiares, de
los pacientes afectados, en el afio 2007, es una asociacion sin fines de
lucro creada para representar a personas que padezcan de Esclerosis

Lateral Amiotrofica en el Peru; el objetivo de esta asociacion es “Convocar
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afectados de ELA en el Peru, para compartir y cumplir objetivos comunes,
promoviendo y solicitando en el Estado Peruano y sus organismos,
Reformas; que permitan mejorar la calidad de vida del afectado”
(Asociacion ELA Peru, 2010).

ASOCIACION

ELA PERU

esclerosis
lateral
amiotréfica

Figura 7. Logo de la Asociacién ELA Peru.

Fuente: Asociacion ELA Peru

Otra de las asociaciones dedicadas al ELA es la asociacion “Hecho con
amor” es una asociacion de apoyo a personas de escasos recursos que
padecen ELA, especialmente del interior del pais. Ofrecen las pruebas
que sean necesaria para el descarte de la enfermedad como Resonancia
Magnética, Electromiografias, Potenciales evocados visuales y auditivos

y/o Puncién lumbar.

Su mision es ayudar a los pacientes a tener un diagndstico certero, sobre
sus problemas. Para tal motivo cuentan con el aporte de diferentes

neurodlogos especializados.

HECHOconAMOR

Figura 8. Logo de la Asociacion hecho con amor.

Fuente: Asociacion hecho con amor
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3.1.3. Estadisticas

En consultas realizadas al Ministerio de Salud del Peru (MINSA), con
atencion a la Oficina General de Tecnologias de la Informacién, a través
del Sistema de Atencion de Solicitudes de Acceso a la Informacion
Publica, se obtuvo informacion estadistica referida al numero de casos
de Esclerosis Lateral Amiotrofica por etapas de vida, segun
departamentos, referido al afio 2018. Los datos provienen de los registros
de las consultas externas en los establecimientos de salud del MINSA y

de los gobiernos regionales de todo el pais.

A. Estadistica por regién del Peru

- ANCASH

Como se puede ver en la tabla 2 en el departamento de Ancash existen 4
personas identificadas que poseen ELA, ademas notar que la poblacién
mas afectada, en esta localidad, son personas adultas mayores de 30

anos.

Tabla 2. Cantidad de personas con ELA en Ancash

EDAD (afios) CANTIDAD
0-11 0
12 - 17 0
18 — 29 0
30 — 59 2
2
4

60 - mas

TOTAL
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- APURIMAC

En el departamento de Apurimac se han registrado 3 casos de ELA,
donde podemos notar que la poblacion afectada esta en los rangos de 0

- 11,18 — 29 y de 60 afios a mas.

Tabla 3. Cantidad de personas con ELA en Apurimac

EDAD (afios) CANTIDAD
0-11 1
12 -17 0
18 — 29 1
30 -59 0
1
3

60 - mas

TOTAL

- AREQUIPA

Arequipa posee 8 casos registrados, con una mayor presencia en

personas entre 30 y 59 afnos y en personas mayores a 60 afos.

Tabla 4. Cantidad de personas con ELA en Arequipa

EDAD (afos) CANTIDAD
0-11 0

12 -17

18 — 29

30 -59

60 - mas

TOTAL

o ~ b O O
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- AYACUCHO

En el departamento de Ayacucho se presentan 3 casos en personas

mayores de 60 afios.

Tabla 5. Cantidad de personas con ELA en Ayacucho

EDAD (anos) CANTIDAD
0-11 0

12 -17

18 — 29

30-59

60 - mas

TOTAL

w w O o o

- CALLAO

En Callao se registré 12 casos, contabilizandose la mayor parte de ellos

en personas mayores a 30 anos.

Tabla 6. Cantidad de personas con ELA en Cajamarca

EDAD (afios) CANTIDAD

0-11 1
12 -17 1
18 — 29 0
30 -59 4
60 - mas 6
TOTAL 12
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CusCoO

En la region Cusco se identifico 7 casos de ELA, de los cuales 5 estan en

la edad de 30 a 59 anos.

Tabla 7. Cantidad de personas con ELA en Cusco.

EDAD (anos) CANTIDAD
0-11 1

12 -17

18 — 29

30-59

60 - mas

TOTAL

N ©O o ©O =~

HUANCAVELICA

En la region de Huancavelica se reporté 1 caso, que corresponde a una

persona mayor de 60 afos.

Tabla 8. Cantidad de personas con ELA en Huancavelica.

EDAD (afios) CANTIDAD
0-11 0
12 - 17 0
18 — 29 0
30 — 59 0
1
1

60 - mas

TOTAL
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HUANUCO

Huanuco es la segunda regién con mayor incidencia del ELA, en la cual
se lleg6 a identificar 24 casos, con mayor influencia en adultos mayores

entre 30 a 59 anos.

Tabla 9. Cantidad de personas con ELA en Huanuco.

EDAD (afios) CANTIDAD

0-11 0
12 -17 0
18 — 29 1
30-59 18
60 - mas 5
TOTAL 24

ICA

En la regidn Ica se presentoé 4 casos, los cuales se pueden observar en la

siguiente tabla.

Tabla 10. Cantidad de personas con ELA en Ica.

EDAD (afios) CANTIDAD
0-11 0
12 - 17 1
18 — 29 0
30 — 59 2
1
4

60 - mas

TOTAL
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- JUNIN

En Junin se registré 4 casos, con mayor incidencia en personas mayores

a 60 anos.

Tabla 11. Cantidad de personas con ELA en Junin.

EDAD (ainos) CANTIDAD
0-M1 1
12 -17 0
18 - 29 0
30-59 0
3
4

60 - mas

TOTAL

- LALIBERTAD

En La Libertad se registré 13 casos, de los cuales la mayor parte estan

entre los 30 y 59 anos.

Tabla 12. Cantidad de personas con ELA en Junin.

EDAD (afios) CANTIDAD

0-11 0
12 -17 0
18 — 29 2
30 -59 7
60 - mas 4
TOTAL 13
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LAMBAYEQUE

Lambayeque es la tercera region con mayor incidencia del ELA,
registrando 18 casos de los cuales la gran mayoria son personas mayores

de 60 anos.

Tabla 13. Cantidad de personas con ELA en Lambayeque.

EDAD (afios) CANTIDAD

0-11 3
12 -17 0
18 — 29 0
30-59 4
60 - mas 11
TOTAL 18

LIMA

Lima es la primera regibn con mayor numero de casos, abarcando
aproximadamente el 63% de casos de todo el Peru; de los casos
registrados solamente 2 corresponden a personas entre 18 y 29 afios, y

registrando la mayor cantidad de casos en personas entre 30 y 59 afos.

Tabla 14. Cantidad de personas con ELA en Lima.

EDAD (afios) CANTIDAD

0-11 9
12 -17 4
18 — 29 2
30 -59 101
60 - mas 96
TOTAL 212
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LORETO

En Loreto se registré 2 casos, los cuales se registran en personas

mayores de 30 afos.

Tabla 15. Cantidad de Personas con ELA en Loreto.

EDAD (afios) CANTIDAD

0-11
12 -17
18 — 29
30 -59

60 - mas

0

TOTAL

PASCO

0
0
1
1
2

Como se puede observar en la tabla 16, la regién Pasco pose 1 casos

registrado de ELA.

Tabla 16. Cantidad de personas con ELA en Pasco.

EDAD (afios) CANTIDAD

0-11 0
12 -17 0
18 — 29 0
30 -59 1
60 - mas 0
TOTAL 1
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PIURA

En la tabla 17, la region Piura pose 14 casos registrados de ELA, con

mayor preponderancia en las edades de 30 a 59 afos.

Tabla 17. Cantidad de personas con ELA en Piura.

EDAD (afios) CANTIDAD

0-11 1
12 -17 0
18 — 29 0
30-59 13
60 - mas 0
TOTAL 14

PUNO

La regidn Puno, registra 2 casos de la enfermedad de ELA como se puede

observar en la siguiente tabla.

Tabla 18. Cantidad de personas con ELA en Puno.

EDAD (afnos) CANTIDAD
0-11 0

12 -17

18 — 29

30 -59

60 - mas

TOTAL

N © N O O
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SAN MARTIN

La regién San Martin es una de las regiones con menor incidencia junto

con las regiones de Pasco y Huancavelica, registrando solo un caso,

como se puede observar la siguiente tabla.

Tabla 19. Cantidad de personas con ELA en San Martin.

EDAD (afios) CANTIDAD

0-11
12 -17
18 — 29
30 -59

60 - mas

0

TOTAL

TACNA

Tacna presenta 2 casos de ELA, como se observa en la tabla 20.

Tabla 20. Cantidad de personas con ELA en Tumbes.

0
0
0
1
1

EDAD (afios) CANTIDAD

0-11
12 -17
18 — 29
30 -59

60 - mas

0

TOTAL

N © O O DN
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- TUMBES

En Tumbes se registré 2 casos, como podemos observar en la siguiente
tabla.

Tabla 21. Cantidad de personas con ELA en Ucayali.

EDAD (afios) CANTIDAD
0-11 0
12 -17 0
18 — 29 1
30 -59 1
0
2

60 - mas

TOTAL

Finalmente, cabe mencionar que, en regiones no mencionadas, no registran

evidencias de casos de personas con ELA.

B. Resumen estadistico

En la figura 9, podemos ver la cantidad de personas con ELA, registradas
en todo el territorio peruano; observar que las regiones con menor
incidencia son San Martin, Pasco y Huancavelica, mientras que la regiéon
con mayor incidencia es lima, contabilizando 212 casos, lo cual
representa aproximadamente el 63% del total de casos, que es 337, a

nivel nacional.
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REGIONES

sanmarin 0 1
pasco 01
Huancaveuca (01
Tumees @ 2
tacna @2
rpuno 2
woreto @ 2
avacucHo (3
apurmac [ 3
junin 7 a
ica a
ancasi 7 a
cusco (07
arequipa [T 8
cawao T 12
LauserTap (7 13
VLT — Y.
Lameaveque [T 18
HuANuco [T 24

uma | 1 212

CANTIDAD DE CASOS

Figura 9. Cantidad de casos registrados por regiones del Peru.

En la siguiente imagen podemos observar que en Peru el ELA tiene mayor
preponderancia en personas entre 30 y 59 afos, representando
aproximadamente el 49% de los casos; la poblacion mayor de 60 afos,

representa el 41% de los casos totales.

30a -59 e

v
Q
é 18a -29a ]
4 7
12a-17a , -

00a -11a

\=_5_\

20 40 60 80 100 120 140 160 180
CANTIDAD DE CASOS

Figura 10. Cantidad de casos registrados por edad.
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3.2.

% passg

S (

REQUERIMIENTOS TECNICOS NECESARIOS PARA EL
DESARROLLO DE UNA INTERFAZ CEREBRO-MAQUINA

Esta etapa se divide en 3 partes importantes que son:

e Conexion de la Cyton Board a la PC.
e Transmision por lab streaming layer.

e Recepcion de las sefales electroencefalograficas por Matlab.

Las 3 etapas mencionadas las podemos ver en forma grafica en la figura
11

| =—

&= PYls| ' erramienta

e . .
PYSerial lab streming

Numpy layer

Figura 11. Etapas de la conexion.

3.2.1. Conexion de la cyton board al pc

El sistema inalambrico, consta de 4 etapas desde la alimentacion de
voltajes a los equipos hasta la presentacion de las ondas cerebrales como
resultados. En la Figura 12, se muestra la etapa de alimentacion
mostrando los valores requeridos por cada equipo, luego la etapa de
equipos seguido por la etapa de procesamiento donde se indica que el
software Matlab sera el encargado de procesar los datos, finalmente se
muestran la etapa de resultados, en la cual se llegara a controlar la silla

de ruedas.
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Etapa de alimentacion Etapa de Equipos Etapa de procesamiento Etapa de resultados

USB Dongle
Alimentacion 5V Programable,
500mA - recibiendo datos y
enviandolos al pc Algoritmo en
Matlab para la
extraccion de
Cyton Board y Daysi caracteristicas Movimiento de

Board, capturando » ‘ la silla de
las ondas cerebrales ruedas

Alimentacion 6V

500mA
Algoritmo en

Matlab para el
procesamiento de

Lapto
ptop las sefales

Alimentacién ” recepcionando las
19.5v 3.33A sefales de las ondas
cerebrales.

Figura 12. Diagrama de especificaciones técnicas basicas.

El sistema OpenBCl es un dispositivo con conexiones para 8 o 16 electrodos que
son ubicados en el cuero cabelludo de las personas. El acceso a los datos es
relativamente facil por su conectividad inaldambrica a través de Bluetooth.

(Ekandem, Davis, Alvarez, James, & Gilbert, 2012)

Para el correcto funcionamiento del OpenBCl se debe usar un ambiente en
donde no haya obstaculos que interrumpan la linea de vista entre el dispositivo
y el ordenador al cual se conectara, caso contrario, el dispositivo presentara
problemas, debido al ruido que pueden ocuacionar estos obstaculos en las

sefales de las ondas cerebrales. (Ekandem et al., 2012)

Las caracteristicas mas relevantes del dispositivo Cyton Board y Daysi Board

son los siguientes:

e Poder de transmisién de hasta 15dBm en Radiofrecuencia.

¢ Rango de funcionamiento de 5 metros.

e Duracion de la bateria de hasta 20 horas aproximadamente.

e Bandas de frecuencia de 2.420 — 2.471 Ghz.

e Se obtiene entre 125 a 256 datos por segundos dependiendo de la

configuracion.

Teniendo en cuenta lo antes mencionado, se conecta la Cyton Board al PC

atreves de su propio USB Dongle el cual cuenta con conexion bluetooth; se
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debe tener en cuenta que, primero se debe realizar la conexiéon del USB
Dongle hacia el pc, y luego se debe encender la Cyton Board, colocando su

interruptor en la etiqueta BLE que es la conexidn por bluetooth.

Para comprobar que el equipo realmente esta funcionando correctamente,
OpenBCI nos proporciona un software, el cual lo podemos encontrar en su
pagina web; se debe obtener el software que corresponda con el sistema
operativo del pc, en mi caso Windows 7 de 64 bits; ejecutamos el archivo .exe
y se nos abrira la ventana, en la cual se realiza las configuraciones necesarias

para la conexion figura 13.

@DF‘ENBCI Shop Issues Help
|| DATA SOURCE SERIAL/COM PORT RADIO CONFIGURATION (v2)
LIVE (from Cyton) [ AutoconneeT anp sTaT svsTem | [eercmama || smws |

LIVE (from Ganglion}
i T CHANGE CHANNEL
| PLavBACK (from file) =G
SYNTHETIC {algorithrmic) [overRioE ponaLe][  AuToscan |
‘ START SYSTEM | | REFRESH LIST ‘

DATA LOG FILE
File Name 2017-06-11_11-27-14

| AUTOGENERATE FILE NAME ‘

[ opersa ] BDF+ |

CHANNEL COUNT (8)

| 8 CHANNELS H 16 CHANNELS ‘

WRITE TO SD (Y/N)?
Do not write to SD...

5 minute maximum

15 minute maximurm

30 minute maximurm

NETWORK PROTOCOLS
None
uppP
05C

LabStrearningLayer (LSL}

| Attempting to open Serial/COM port: COM9

Figura 13. Configuracion para probar el funcionamiento del equipo.
Una vez echas las configuraciones iniciamos el sistema desde Start

Systemy luego en Start Data Stream, con lo cual nos mostrara las sefales

qgue se estan recibiendo en ese momento ver figura 14.
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3.2.2.

System Control Panel a @ (m]=I= N =] Shop Issues Help

Notch BP Filt
S0Hz 1-50 Hz tayant

BT T
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Time (s)

II Data stream started.

Figura 14. Lectura de sefales.

Con ello comprobamos que la Cyton Board esta en perfectas condiciones
para poder trabajar ademas se comprueba que la conexion con la PC es

exitosa.

Transmisién por lab streaming layer

El lab streaming layer (LSL) es una capa de transicién que se implementa
con la finalidad de transmitir datos via streaming, lo cual permite hacer un
analisis de datos en tiempo real; para implementarlo se debe cumplir con

los siguientes requisitos:

¢ Instalar Python.
e Instalar las librerias pyserial, pylsl y numpy en Python.

e Descargar la herramienta OpenBCIl_LSL de github.

El software Python lo obtenemos de su propia pagina web. Las librerias
se pueden instalar en Python ejecutando “pip”, para ello abrimos la
terminal DOS del pc, nos dirigimos al directorio principal tecleando cd/,
una vez alli tecleamos pip install nombre, el término “nombre” se debe

reemplazar por el nombre de la libreria a instalar (pyserial, pylsl y numpy)
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segun corresponda, el sistema automaticamente descargara e instalara

los archivos necesarios.

Cumplidos los requisitos ya podemos realizar la transmision por LSL, para
ello abrimos una terminal DOS, nos dirigimos al directorio principal y
desde alli nos dirigimos al directorio que contenga los archivos de la
herramienta OpenBCI_LSL, para ello tecleamos cd\ seguido de la ruta del
archivo por ejemplo cd\Users\home\Downloads\OpenBCI_LSL-master;
una vez dentro del directorio ingresamos el comando python
openbci_Isl.py --stream, con lo cual iniciaremos la configuracion de la
Cyton Board ver figura 15

-

Bl C\Windows\system32\cmd.exe - python openbci_lslpy --stream

Microsoft Windows [Uersién 6.1.76H11]
Copyright <c> 2889 Microsoft Corporation. Rezervados todosz los derechos.

C:“Users'witmandcds
C:s>CdNUsersswitmansDownloads~open bcisOpenBCI_LSL-—master

C:~Usersswitman~Downloads~open bhciOpenBCI_LSL-master>python openbci_lsl.py ——st
eam

LSL Configuration:
Stream 1
Hame: openhci_eeg
Type:= EEG
Channel Count: 8
Sampling Rate: 258.8
Channel Format: float32
Source Id: openbhci_eeg_idi®A
Stream 2:
Hame: openbhci_aux
Type:= AU
Channel Count: 3
Sampling Rate: 258.8
Channel Format: float32
Source Id: openhci_aux_idi®@A

Electrode Location Montage:
¥

*C3',. 'C4 -'TS‘, ‘Te’,. *01Y . *02°1

#start" to stream to LSL
"sztop" to stop stream.
"sexit" to disconnect the hoard.

Figura 15. Iniciaciéon de Python.
Como podemos ver ya contamos con la conexion a la Cyton Board; para

inicial la transmision ingresamos el comando “/start”; con ello la

transmision por LSL estara completa.
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3.2.3. Recepcion de las seiales EEG por Matlab

A.

Herramientas para Matlab

Para la recepcién de datos, existen herramientas en continuo
desarrollo planteadas para ser usado con Matlab; entre ellas
tenemos EEGLAB, BCILABy ERPLAB, estas herramientas,
excepto ERPLAB, fueron desarrolladas por “Swartz Center for
Computational Neuroscience” (SCCN) y distribuidas gratuitamente
para ayudar a investigadores en el procesamiento de sefales con
el Matlab.

- EEGLAB

En (“EEGLAB - SCCN,” 2017) Fue desarrollado con la
finalidad de ser una caja de herramientas interactiva para
Matlab enfocado en el procesamiento de EEG y MEG
ademas de otras sefiales electro-fisicas continuas y eventos
relacionados al analisis de componentes independientes
(ICA). Las caracteristicas del EEGLAB son:

Interfaz grafica de usuario.

datos multiformato importadores.

desplazamiento de datos de alta densidad.
funciones interactivas de trazado.

ICA y las transformaciones de tiempo / frecuencia.
Evento y localizacion del canal de manipulacion.
modelado de la cabeza.

estructura de datos definida EEG.

VvV V.V V V V VYV V VY

Muchos plug-in de herramientas avanzadas.
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File Edit Tools Plot Study Datasets Help

—No current dataset '
- Create a new or load an existing dataset:
Use "File = Import data" {new)
Or "File > Load existing dataset" {old) l
- If newy, i
"File = Import epoch info" (data epochs) else |

"File = Import event info" {continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File » Save dataset" (save dataset) |
- Prune data: "Edit > Select data"
- Reject data: "Tools > Reject continuous data"
- Epoch data: "Tools = Extract epochs"
- Remove baseline: "Tools = Remove haseline”
-RunICA: "Tools = Run ICA"

Figura 16. Herramienta EEGLAB.
Fuente: Open BCI.

- BCILAB

(“BCILAB - SCCN,” 2017) fue desarrollado en Matlab, esta
herramienta usa EEGLAB como base para el disefio de
prototipos, pruebas, evaluaciéon, experimentacién con
interfaces cerebro computador; posee un entorno grafico
desde donde se puede controlar a EEGLAB con secuencias

de comandos.

Data Source Offline Analysis Online Analysis Settings Help

CRRRdBDBREB0|xux(N|?

Figura 17. Herramienta BCILAB.
Fuente: Open BCI.

- ERPLAB

En (Lopez-Calderon & Luck, 2014) nos mencionan que el
ERPALB es una herramienta Open Source, para procesar y
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File Edit Tools Plot Study |ERPLAB ERPsets | Datasets Help =

No current dataset

analizar datos de los potenciales relacionados con eventos
(ERP) en Matlab. ERPLAB esta basada en EEGLAB, en el
cual se anade ERPLAB para brindar herramientas mas
robustas en el procesamiento de EEG, ademas proporciona
la cuantificacién de varias amplitudes y latencias, mapear el
cuero cabelludo, recombinacion de expresiones algebraicas,
entre otras opciones; el acceso a ERPLAB se pude realizar
mediante la interfaz grafica de EEGLAB o a través de lineas

de comandos en Matlab.

— Create a new or load an existing dataset:
Use "File > Import data”™ (new)
Or "File > Load existing dataset" (old)

- If new,
"File > Import epoch info" (data epochs) else
"File > Import event info" (continuocus data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset" (save dataset)

- Prune data: "Edit > Select data"

- Reject data: "Tools > Reject continucus data"

— Epoch data: "Tools > Extract epochs"

- Remove baseline: "Tools > Remove baseline”

— Run ICA: "Tools > Run ICA"

Figura 18. Herramienta ERPLAB.
Fuente: Open BCI.

Para este proyecto se usara las librerias de la herramienta
BCILAB ya que es una herramienta especialmente
preparada para realizar interfaces BCl, ademas esta
herramienta integra al EEGLAB asi como también a otras

herramientas, lo que lo hace apropiada para el proyecto.

El BCILAB se puede obtener directamente desde su pagina
web; una vez descargada, debemos ubicarnos, con el
Matlab, dentro del directorio principal de BCILAB,
seguidamente, en la linea de comandos escribimos bcilab

con lo cual cargara todas las librerias necesarias y
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seguidamente se nos abrira la interfaz de BCILAB, con la
cual ya podemos iniciar la recepcién de la data con un
procedimiento sencillo que consta de escribir en la linea de
comandos de Matlab el comando ReceiveData lo cual
ejecuta un archivo script basico preparado para la recepcion
de datos via LSL.

B. Obtencion de las seiales electroencefalograficas

e Colocacion de electrodos

Lo electros se colocaran segun el sistema de
posiscionamiento10/20; La posicién de los electrodos se realizara en

las posiciones A1, A2, C3 y C4 como se muestra en la figura 19.

Figura 19. Posicionamiento de electrodos.

Las conexiones en la Cyton Board se realizaran de acuerdo a la
figura 20, en la que se puede observar y relacionar los colores con
los sectores a conectar segun el sistema 10/20 de la figura 19,
observar que se conectara un cable para cada oreja, de los cuales
uno funciona como referencia y el otro se usa para cancelar el ruido.

Los demas electrodos se deben conectar en cualquier canal en mi
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caso usare los canales 1y 2 en los que las lecturas se realizan entre

el electrodo y la referencia.

Figura 20. Conexiones realizadas en la Cyton Board.

e Obtencién de datos

a. Obtencion de datos con la aplicacion de OPENBCI
Realizando las conexiones mencionadas en el apartado
anterior se procede a la recoleccion de datos, primeramente,
con el software proporcionado por OpenBCl, con la finalidad de
poder comprobar que las conexiones de los electrodos estén
bien hechas, ademas permite corregir errores en la conexion.
En la figura 21, se pude apreciar las sefales del cerebro, de
una persona voluntaria, obtenidas por la Cyton Board en la que
podemos observar que los electros han sido conectados en los
canales 1y 2, ademas el software nos permite ver, en el lado
superior derecho, la transformada rapida de Fourier de las

senfales obtenidas.
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Figura 21. Grafico real de los datos obtenidos.

b. Obtenciéon de datos con Matlab

Para la obtener los datos con Matlab primeramente
modificamos el cddigo de ejemplo que viene con la herramienta
lab streaming layer que se encuentra dentro del BCILAB, el
cual posee un bucle while para realizar las lecturas de la sefal
recibida, este bucle no es de mucho beneficio ya que es infinito,
por lo que es necesario acotarlo para poder obtener los datos
solo por un tiempo limite, el cual sera indicado por el usuario;

el bucle original es el siguiente codigo:

while true
[vec,ts] = inlet.pull _sample();
fprintf('%.2f\t',vec);
fprintf('%.5f\n',ts);

end

El cual se modificd, como ya se menciond, acotando el bucle

while a un tiempo definido, ademas se le agrego una peticion
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para que el operador del sistema pueda ingresar el tiempo y
nombre del archivo en el command window, estas acciones
ayudaran a simplificar el hecho de cambiar el tiempo y el
nombre cada vez que se requiera, finalmente el cédigo quedara

de la siguiente manera.

nombre=input('Name to file: ','s");
tiempo=input("Time to record "in seconds": ');
t=0;
datos=fopen([nombre,".txt'],'wt");
tic;
while t<tiempo
t=toc;
[vec,ts] = inlet.pull sample();
fprintf(datos, '%.2f\t',vec);
fprintf(datos, '%.5f\n',ts);
end
fclose(datos);
winopen([nombre,'.txt']);

El cédigo presentado es capaz de guardar todos los datos

recibidos por el periodo de tiempo y con el nombre indicado por

el usuario.
£ atras.txt: Bloc de notas - b
Archivo Edicion Formato Ver Ayuda
42173.63 51511.38 -187500.02 -187500.82 -187500.82 -187500.02 -187500.82 -187500.02 18474.8% A
48859.68 47630.88 -187500.02 -187500.82 -187500.02 -187500.82 -187500.82 -187500.02 10474.89
53837.83 4e836.32 -187508.82 -187500.82 -187500.82 -187500.82 -187508.82 -187508.82 18474.89
5e875.2e 4778l1.1e -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 18474.89
42964 .16 51242.80 -187580.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.89
46927.91 48605.46 -187500.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.89
53339.69 45847.59 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 18474.89
58726.39 47479.17 -187500.02 -187500.82 -187580.02 -187580.82 -187500.82 -187500.02 18474.90
44213.79 50748.67 -187500.02 -187500.82 -187500.02 -187500.82 -187500.82 -187500.02 10474.90
44985.81 49533.32 -187500.02 -187500.82 -187500.82 -187500.82 -187500.82 -187500.02 10474.90
53258.33 45728.52 -187508.82 -187500.82 -187500.82 -187508.82 -187500.82 -187508.82 18474.90
51175.38 47135.20 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 18474.90
45652.98 50054.41 -187580.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.98
43452 .44 5@459.80 -187500.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.98
52783.13 45874.56 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 18474.90
51658.83 46856.27 -187500.02 -187500.82 -187580.02 -187580.02 -187500.82 -187500.02 18474.90
47897.38 49324.29 -187500.02 -187500.82 -187500.02 -187500.82 -187500.02 -187500.02 10474.90
42374.15 51889.54 -187500.02 -187500.82 -187500.82 -187500.82 -187500.82 -187500.02 10474.90
51821.31 4e252.78 -187508.82 -187500.82 -187500.82 -187500.82 -187508.82 -187508.82 18474.90
52179.45 4e568.63 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 -187508.82 18474.90
48483 .44 48e667.75 -187580.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.98
42018.46 51457.31 -187580.82 -187500.82 -187580.82 -187580.82 -187580.82 -187580.82 18474.90

£

Linea 7575, columna 98

Figura 22. Datos guardados desde Matlab.
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En la figura 22 podemos observar los datos en el archivo de
texto creado por Matlab, el cual ha sido generado a manera

de ejemplo en un tiempo de 30 segundos.
Interfaz grafica en Matlab

Anteriormente se logré obtener un archivo con los datos de las
sefales cerebrales, cabe mencionar que el proceso para obtenerlo
es tedioso asi que se decidié disefiar una interfaz grafica que
permita capturar la cantidad deseada de datos y ademas que la
conexion y todo el procedimiento anteriormente descrito sea
automatico, con la finalidad de preparar los archivos necesarios

para la etapa de procesamiento.

La interfaz grafica cuenta con 4 botones principales (figura 23) que
son: El botdn conectar, es el encargado de cargar Python y
BCILAB; EI botén iniciar, se encarga de empezar la captura de
datos con los parametros especificados; ElI boton Python,
encargado de iniciar solo Python; El boton BCILAB encargado de
iniciar solo BCILAB.

CONECTAR PYTHON

INICIAR BCILAB

Figura 23. Botones de la interfaz grafica.
El sistema cuenta con una zona donde el usuario debe ingresar
datos basicos (figura 24) como: nombre, repeticiones, tiempo y
descanso; repeticiones son el numero de veces que el sistema va
a capturar datos por cada paciente ademas también es el numero
de archivos diferentes que nos va a generar; en la peticién de
tiempo se debe ingresar el tiempo en el que la persona, a la que se
le esta grabando los datos, debe permanecer concentrada en la
indicaciones que se le dé; en descanso se debe ingresar el tiempo
de descanso entre una instruccién y otra, por defecto seran 3

segundos.

49



NOMBRE

REPETICIONES

TIEMPO

DESCANSO 3

Figura 24. Entradas de texto.
Se coloco una zona donde se mostrara las indicaciones (figura 25)
respectivas para las personas a las cuales se les esta tomando los
datos, esta zona muestra imagenes aleatorias, que corresponden
las tres direcciones que se puede seguir al conducir una silla de
ruedas (derecha, izquierda y adelante); la importancia de esta zona
radica en que las imagenes indican a la persona el movimiento que
debe imaginar como: movimiento del brazo derecho, movimiento
del brazo izquierdo, 0 ambos para las imagenes derecha, izquierda

y adelante respectivamente.

IMAGEN

Figura 25. Imagen de la direccion elegida al azar.
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Finalmente, la interfaz de usuario quedo como la imagen mostrada
en la figura 26, en la cual podemos ver todos los elementos

descritos anteriormente.

RECOPILACION DE DATOS

IMAGEN

NOMBRE | witman |
REPETICIONES | 192
TIEMPO | 1 |
DESCANSO 3

Figura 26. Interfaz grafica.

Una parte importante de una interfaz grafica desarrollada en Matlab,
son las acciones que tendran los botones los cuales se describen a

continuacion:

a. Botén conectar

Como se mencion6 anteriormente este botdn se encarga de iniciar

Python y BCILAB; para iniciar Python se utilizé el siguiente codigo:

% INICIO DE PYTHON

system('cd/");

system('E:");

dos ('E:\wjad\tesis\software\BCI\archivos\Conexion-
OpenBCI-Matlab.bat&')
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como podemos ver en la ultima linea del codigo se esta ejecutando
un archivo llamado “Conexion-OpenBCIl-Matlab.bat” este archivo
contiene instrucciones de la direccion del archivo necesario para
iniciar la ventana en Python que nos permitira iniciar la transmision

LSL, el codigo que contiene el archivo es el siguiente:

cd/

E:

cd\wjad\tesis\software\open bci old\OpenBCI LSL-master
python openbci Isl.py --stream

cmd /k run.bat

finalmente, para iniciar BCILAB se requiere ubicarnos en el
directorio donde se encuentra la herramienta y desde alli iniciamos
BCILAB, todo esto es un proceso ya establecido en el siguiente
codigo:

% INICIO DE BCILAB

clear;

clc;

path(path,'E:\wjad\tesis\software\BCI\BCILAB-1.1");
bcilab;

. Botoén iniciar

Este botdn es el mas importante ya que es el encargado de manejar
toda la interfaz grafica; el cdédigo necesario se realiza cumpliendo
con el diagrama de flujo de la figura 27, para el cual se debe seguir
con los siguientes pasos:
- Carga de imagenes, esta aparte se encarga de cargar todas
las imagenes que el sistema necesita.
- La lectura de parametros, se encarga de leer lo que el
usuario ingreso en las entradas de texto.
- La etapa de conversion de variables, en esta seccion se
convierten las variables del tipo texto a numero para luego

poder realizar operaciones con ellas.
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Se carga la libreria necesaria para grabar datos.

Se elige el directorio, en el cual seran guardados todos los

archivos que se genere.

Se inicia con un bucle del tipo FOR el cual realiza las

funciones principales del programa, dentro de este bucle se

tiene dos partes la primera es la que se ejecuta durante el

periodo de descanso y la segunda es la que se ejecuta

durante el periodo en el que se muestra una imagen; las

acciones que se realizan acciones como:

v
v

Se generan numeros aleatorios desde el 1 hasta el 3.
Se elige uno de los nombres de las 3 direcciones,
para colocarlo como parte del nombre del archivo.
Se genera el nombre del archivo, concatenando el
nombre que ingreso el usuario, el nombre de la
direccion aleatoria elegida en la parte anterior y el
numero en el que se encuentra el bucle FOR, un
nombre de ejemplo puede ser “Witman_derecha_4”,
“Witman_adelante 57, etc, de esta manera sabremos
el nombre del usuario, que sefial se capturo y en que
iteracion se capturo.

Se inicia un bucle WHILE en el cual se captura los
datos durante el periodo de descanso indicado por el
usuario.

Al terminar la captura se decide qué imagen se
mostrara segun el numero aleatorio elegido al inicio.
Se inicia el segundo bucle WHILE en el cual se
capturan datos mientras el usuario ve la imagen
mostrada, por el periodo de tiempo indicado.
Finalmente se repiten todos los pasos dentro del
bucle FOR el cual al finalizar muestra una imagen de

agradecimiento al usuario.
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Se debe mencionar que Los botones Python y BCILAB contienen
los respectivos programas para iniciar Python y BCILAB descritos

anteriormente.

Finalmente se debe recalcar que el movimiento imaginario de los
brazos, derecho e izquierdo indican las direcciones de movimiento
de la silla de rueda a la derecha e izquierda respectivamente,
ademas, el movimiento imaginario de ambos o ningun brazo
indicara el movimiento hacia adelante, para retroceder es necesario
dar un giro de 360° para que la persona pueda ver hacia dénde va

ya que es peligroso retroceder sin conocer que hay detras.
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——————— > DESDE R=0 HASTA

(INICIO |

m——

_~CARGAR IMAGENES —

_—LEER PARAMETROS —

| CONVERSION DE VARIABLES |

[ INICIO DE LAS LIBRERIAS |

| DIRECTORIO DE DESTINO |

R=REPETIR

R=<=REPETIR *
| RESTO = Numero aleatorio entre 1y 3 |

P2 = ADELANTE

P2 = DERECHA

P2 = IZQUIERDA

| NOMBRE DEL ARCHIVO = CONCATENAR NOBRE, P2 YR |

—MIENTRA T<=DESCANSO

Sty

IMAGEN ADELANTE

| IMAGEN IZQUIERDA |
b |
- - NO
< MIENTRAS T<=TIEMPQ =
GRABAR DATOS
R ES IGUAL A REPETIR?

NO

[ MOSTRAR IMAGEN DE AGRADECIMIENTO|

[FIN e

Figura 27. Diagrama de flujo.
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3.3.

3.3.1.

PROCESAMIENTO DE LAS SENALES EEG

Esta etapa del proyecto es la mas importante ya que es donde se realizara
todo el procesamiento necesario para el funcionamiento del sistema. Esta

etapa de manera general se divide en sub etapas como:

e Pre procesamiento.
e Extraccion de caracteristicas.

e Clasificacion.

Se debe tener en cuenta que antes de realizar el procesamiento se
obtuvieron datos de un voluntario sano, fueron guardados un total de 192
archivos, cada archivo consta de 10 segundos de datos a una frecuencia
de muestreo de 250Hz; el tiempo se divide en dos partes de las cuales
una corresponde a 3 segundos de descanso entre una indicacién y otra,
los 7 segundos restantes corresponden a la sefal en si del movimiento
imaginario de los brazos derecho e izquierdo, los cuales representan al
movimiento de la silla de ruedas a la derecha e izquierda respectivamente,
ademas el movimiento de imaginario de ambos brazos corresponde al

movimiento hacia delante de la silla de ruedas.

Pre procesamiento

En esta etapa primeramente realizaremos la lectura de los archivos que
contiene las sefales, para ello Matlab cuenta con el comando dir, el cual
captura todos los nombres de los archivos que se encuentran dentro de
una carpeta especifica; primeramente, le decimos a Matlab donde

encontrar la carpeta con los comandos:

path(path,'E:\wjad\tesis\software\BCI\archivos");
cd E:\wjad\tesis\software\BCI\archivos

seguidamente aplicamos el comando antes mencionado
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directorio=dir('DATA");

el resultado de este comando es una variable conteniendo todos los
nombres de los archivos que se encuentran dentro de la carpeta data, ver

figura 28.

®a Variables - directoric @ X
directorio

[E| 4871 struct with 5 fields

Fields [se| name [ bytes

2 . 0

3 '‘Pruebal__a... 252198

4 'Pruebal__a... 252198

5 '‘Pruebal__a... 252198

] 'Pruebal__a... 252198

7 '‘Pruebal__a... 252198

g 'Pruebal__a... 252198

g9 '‘Pruebal__a... 252198

10 'Pruebal__a... 252193 ,
£ >

Figura 28. Lista de nombres de los archivos que estan dentro de la carpeta DATA.

para que Matlab realice operaciones con el contenido de los archivos de
texto estos deben transformarse en matrices, esta operacion se realiza

con los siguientes comandos:

fichero=directorio(3).name;

archivo=fopen(fichero,'');

info = textscan(archivo,'%f %f %t %t %t %t %t %t %ft);
data=cell2mat(info);

fclose(archivo);

el numero 3 de la variable directorio indica que se va a tomar el primer
nombre de la lista ver figura 27, este numero debe ir cambiando para
poder tomar todos los archivos que se desee; el parametro ‘r’ viene de la

palabra “read” lo cual indica que se abrira el archivo solo para la lectura
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de los datos que contiene; el parametro ‘%f’ indica que se debe buscar
numeros del tipo float (coma flotante); el comando, cell2mat, realiza la

conversion de los datos a una matriz.

Teniendo en cuenta que la frecuencia de muestreo de la Cyton Board es
de 250 Hz, con lo cual se deberia obtener 250 datos por cada segundo;
por lo que en 10 segundos de captura deberian existir 2500 datos, lo cual
no sucede, debido a retardos en la captura de datos por parte de Matlab
y de los procesos que realiza para tal fin, no se logra capturar la cantidad
de datos tedrica, es por ello que se realiza una homogenizacion de los
datos, con la finalidad de que todos las variable capturadas tengan 2500

datos.

Como se menciond en la seccion anterior, se usara dos canales (3 y 4) de
la Cyton Board, la informacion que se captura por estos canales se ubica
en las columnas 3 y 4 de los archivos de texto, para poder trabajar con las

sefales es necesario separarlas, para ello usamos los comandos:

Cl=data(:,3);
C2=data(:,4);

Estos comandos capturan toda la informacion de las columnas 3y 4y
guardan los datos en las variables C1 y C2 respectivamente; si graficamos

una de las senales, se veria una sefal similar a la de la figura 29.
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Figura 29. Seiial sin procesar.

La figura 29 corresponde a sefal “cruda” (sin procesar), es por ello que se
debe aplicar filtros para mejorar el aspecto de las sefales; teniendo en
cuenta la teoria, sabemos que las sefales del cerebro oscilan entre 4 y 30
Hz aproximadamente, ademas sabemos que la frecuencia de muestreo
de las sefiales es de 250 Hz, con esta informacién se disefia un filtro pasa
banda Butterworth, en la aplicacion “Filter Designer” de Matlab, con una
frecuencia minima de 1Hz y una frecuencia maxima de 30Hz, de esta
aplicacion obtenemos la funcién de transferencia, que es:
s?—1
s? —1.951s + 0.9535

de la aplicacion “Filter Designer” se exporta los coeficientes del filtro con
los cuales ya podemos aplicar el filtro correspondiente a nuestros datos,
con el siguiente cédigo:

C1=filtfilt(b,a,C1);
C2=filtfilt(b,a,C2);
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Donde b y a son los coeficientes exportados en el paso anterior. Con el
filtro descrito anteriormente se obtiene una mejor sefal, la cual podemos

ver en la figura 30.

File Edit View Insert Tools Desktop Window Help o
NEEde k| RARUDEL- S DE|aD
s00)

\ Amplitud

Figura 30. Senal filtrada con un filtro pasa banda.

Lugo de obtener la sefal ya filtrada debemos conocer las frecuencias
presentes en la sefal, para ello calculamos la transformada rapida de

Fourier, para ello implementamos el siguiente codigo:

fft1 = abs(fft(C1));

N = length(C1);

fs = 250;

bin_vals = [0 : N-1];

fax Hz = bin_vals*fs/N;
freq_hz = linspace(0,Fs,N);
N_2 =ceil(N/2);
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fit1=2*fft1/N;
plot(fax_Hz(1:N_2),fft1(1:N_2));

con el cual se obtiene la grafica de la figura 31.

£y Figure 1 - O
File Edit View Insert Tools Desktop Window Help
Dgde @ 0| & [E
%108
1.9 \ Magnitud
Frecuencia
60 80 100 120 140]

Figura 31. Seinal de la transformada rapida de Fourier.

Fuente: Elaboracién propia.

3.3.2. Extraccion de caracteristicas

Primeramente, para la extraccién de caracteristicas debemos tener en

cuenta una ecuacioén importante como la Transformada rapida de Fourier,

la cual es un algoritmo que permite calcular la Transformada Discreta de

Fourier, que es usada comunmente en tratamiento de imagenes y senales

digitales. La ecuacion de la transformada rapida de Fourier es:
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n
V() = Y X(HwI O
j=1

(—2mi)
W,=e n

Esta ecuacion es implementada por Matlab, y para poder usarla se realiza
a través del comando fft(sefial), con este comando se aplican a nuestras
sefales las ecuaciones antes mencionadas, dandonos como resultado
una matriz de datos, los datos de esta matriz todos son negativos por ello
es necesario calcular su valor absoluto de todos los valores, lo cual lo
realizamos con el comando abs(fft(sefial)), un ejemplo claro de los
resultados del calculo de la transformada rapida de Fourier lo podemos

ver en la figura30 de la seccidn anterior y su respectivo cédigo.

Otra de las funciones matematicas a usar en el promedio, la cual se define
como funcién dada para un vector aleatorio “A” con “N” datos escalares.
La siguiente funcién aplica para el célculo del promedio de cualquier
cantidad de datos. Esta ecuacion se usa a través del comando

mean(datos).

Para extraer caracteristicas se implementa un algoritmo (figura 32) capaz
de extraer caracteristicas esenciales de cada senfal, en el rango de 8 a
13Hz y de 13 a 25Hz; el algoritmo inicia leyendo los archivos en los cuales
se encuentran los datos correspondientes a los canales 3 y 4, de este
archivo se extrae uno de los calanes, este posee 2500 datos, que se han
obtenido con una frecuencia de muestreo de 250Hz, por lo tanto 1
segundo de datos corresponde a 250 datos, seguidamente, se agrupan
los datos de forma alterna de la siguiente manera: del dato 1 al 250, del
dato 2 al 251, del dato 3 al 252, etc. hasta concluir con la cantidad total de

datos; a cada grupo se le aplican filtros y se calcula la Transformada
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Rapida de Fourier, de la cual se obtiene las siguientes caracteristicas:

promedio de los valores y maximo valor, estos datos son agrupados vy

finalmente guardados en archivos diferentes.

-

Leer Archivo

X>4

Extraer Datos del Canal ”x”

7> length(Data)-(Fs-1)

Extraer 1 Segundo de Datos

}

Aplicar Filtros

Aplicar Transformada
Rapida de Fourier

v

Promedio de

]
v

los Valores Maximo Valor

1 |

Agrupar Caracteristicas -

Guardar Datos <

Figura 32. Diagrama de flujo de la extraccion de caracteristicas.

!
—

El bucle principal de la extraccion de caracteristicas los podemos ver a

continuacion.

for c=1:(cantData-(Fs-1))
intervalo=Data(c:c+(Fs-1));

% APLICACION DE FILTROS
fi8 13=filtfilt(b3,a3, intervalo);
fi13 25=filtfilt(b4,a4, intervalo);

%CARACTERISTICAS BANDA ALFA DE 8 A 13 Hz

nfft = 2*nextpow2(length(fi8 13));
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Pxx = abs(fft(fi8 _13,nfft));
% valor promedio
Av_Feq(c,:) = mean(Pxx);

% maximo valor
Max Feq(c,:) = max(Pxx);

% CARACTERISTICAS BANDA BETA DE 13 A 30 Hz
nfft = 2”nextpow?2(length(fil3 25));
Pxx = abs(fft(fil13_25,nfft)).”2/length(fil3 25)/Fs;

% valor promedio
Av_Feqg2(c,:) = mean(Pxx);

% maximo valor

Max Feq2(c,:) = max(Pxx)
end
con Este Cédigo Podemos calcular las caracteristicas de las sefiales,
como podemos ver al inicio del codigo se respeta la formacion de grupos
antes mencionado para el procesamiento, se aplican los respectivos
filtros, y con la ayudada de la transformada rapida de Fourier, podemos

hallar las caracteristicas de las sefales en las bandas alfa y beta.

En la figura 33 podemos ver las senales correspondientes al movimiento
imaginario de los brazos derecho e izquierdo, podemos notar que es
posible diferenciar las sefales a través de las caracteristicas planteadas,
ya que las sefales cuando hay sefales de movimiento se separan, de

esta forma se logra una clara diferenciacién de las sefiales.
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Figura 33. Sefiales del movimiento imaginario de los brazos.
Clasificacion

Para la etapa de clasificacion primeramente debemos conocer las
funciones que utiliza el algoritmo de Andlisis de Discriminante Lineal
(LDA); Segun (Shuiwang Ji & Jieping Ye, 2009) y (Yang, Liu, Jin, & Xu,
2011) el LDA conocido también como discriminante lineal de Fisher,
llamada asi por su inventor Sir RA Fisher, viene siendo aplicado hace
décadas, el cual tiene un enfoque estadistico para reducir la
dimensionalidad de los datos, calculado una proyeccion optima, con la
finalidad de minimizar la distancia dentro las clases y maximizar la
distancia entre clases. la LDA clasica, requiere que la matriz de dispersion
total no sea singular sin embargo, segun (Chu, Liao, Ng, & Wang, 2015)
en muchos problemas modernos tales como recuperacion de informacion,
reconocimiento facial, aprendizaje automatico, bioinformatica analisis de
datos, etc, la matriz de dispersion total en cuestion puede ser singular, ya
que el espacio dimensional de los datos suele ser muy alto y generalmente
las dimensiones excede el numero de puntos de los datos generandose

un problema de muestreo o singularidad.
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En (Shashoa, Salem, Jleta, & Abusaeeda, 2017) y (Markopoulos, 2017)
se describen diversas formulas matematicas y algoritmos de LDA, se
menciona por ejemplo que se puede usar el LDA para clasificar una
observacion X de un vector g-dimensional la cual se obtiene por la
observacion de una de varias clases que pueden ser desconocidas; una
de la varia formas de describir al LDA es mediante el uso de modelos de
probabilidad; Suponiendo que la clase ith tiene una densidad f;(X) y una
probabilidad ;. teniendo en cuenta fa formula de Bayes, que nos dice

P(class = i|X) = ﬂ
% 0w

Para demostrar la regla de Bayes o clasificador, que dice que la

clasificacion de la probabilidad condicional mas grande obtendra el menor

numero esperado de errores, asumimos que la clase i tiene una

distribucién gaussiana con media wui y covarianza ), , con ello se

demuestra que clasificar a la probabilidad condicional maxima es

equivalente a clasificar

arg max; (L;)

Donde L; es la funcién discriminate

-1 -1
L= XTZ pi — HLTZ ui/2 + log(m;)

Cuando se utiliza la las estimaciones de maxima similitud para ui tener en
cuenta que L; es una funcion lineal de X ya que con ello llegamos al

procedimiento LDA.

Para la clasificacidon de los datos se realiza la codificacion respectiva de
esta etapa, siguiendo el esquema mostrado en la figura 34, la cual lee uno
por uno los archivos guardados en la etapa anterior, todos los datos leidos
los divide en dos grupos iguales, de los cuales uno es nuestro test y el
otro grupo corresponde a los datos de entrenamiento; ambos grupos se
introducen en la funcion classify de Matlab con los siguientes parametros:

entrenamiento, test, clase y método, en el parametro método se debe
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indicar el tipo de clasificacidn a realizar, en nuestro caso es lineal, lo cual
se indica como 'linear’, producto de la ejecucidon este cogido se genera
una estructura de datos, en la cual se encuentras los respectivos
coeficiente de la funcion lineal, con estos coeficientes reconstruimos una

funcién como la siguiente:

f(x)=ax+tbh

De la cual reemplazamos a y b por los coeficientes lineal y constante
respectivamente, lo cuales se obtienen del paso anterior, una vez
reconstruida la funcion, ya es posible aplicarla para nuevos datos, de los
cuales estan en el rango f(x)<0<f(x), es decir obtenemos valores menores
a cero, cero y valores mayores a 0, de los cuales, a todos los valores
menores a cero le asignamos el valor 1, a todos los valores cero le
asignamos el numero 2, y finalmente a todos los valores mayores a cero
le asignamos el numero 3, estas asignaciones de los valores 1,2,3 se hace
con la finalidad de facilitar el envio de estos datos a la silla de ruedas,
cabe mencionar que los valores 1,2,3 son las indicaciones izquierda,

adelante y derecha respectivamente.
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Leer Archivos de Caracteristicas

!

Dividir los datos (test y
entrenamiento)

l

Clasificar(entrenamiento, test,
clases, método)

!

Reconstruir la funcion

l

Aplicar la funcion en nuevos
datos

l

Normalizar resultados

!

Enviar resultados a la silla de
ruedas

|
——

Figura 34. Diagrama de flujo de la clasificacion.

3.4. DISENO DE UN PROTOTIPO DE SILLA DE RUEDAS A ESCALA

Para poder comprobar que el algoritmo funciona, se necesita un prototipo
de silla de ruedas, la cual disefiamos y construimos, con la ayuda de una
impresora 3D. En la figura 35 podemos ver el disefio de las estructuras
correspondientes al lado derecho e izquierdo de la silla de ruedas, en el
diseiio podemos ver que se cred un espacio adecuado para los motores

respectivos para cada llanta.
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Izquierda Derecha

Figura 35. Estructuras derecha e izquierda de la silla de ruedas.

Ademas, también se disefié un sistema de acople para una rueda loca,
la cual se acopla en la parte delantera de la silla de ruedas, el cual

podemos ver en la figura 36.

Figura 36. Acople para la rueda delantera.
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Las llantas principales, son las mas grandes y van directamente
acopladas a los motores, el disefio de estas las podemos ver en la figura
37.

Figura 37. Diseno de las llantas principales.

Para poder observar el diseno final de todo el prototipo de silla de ruedas,
ensamblamos todas las partes, de lo cual se obtiene un disefio final, la
cual podemos ver en la figura 38 en la cual se muestra 7 vistas diferentes
del disefio en donde se pude apreciar la mayor parte de piezas de la silla

en general.
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6 5

Figura 38. (1) vista isométrica, (2) vista posterior, (3) vista superior, (4) vista derecha, (5)

3.5.

3.5.1.

vista frontal, (6) vista inferior, (7) vista izquierda.

Finalmente, todos los archivos del disefio se guardan en formato stl que
es el formato con el que se pude realizar la impresion 3D de las piezas
disefadas, una vez impresas todas las piezas, ensamblamos la silla de
ruedas, el ensamblaje completo lo podemos ver en la figura 43. de la

siguiente seccion.

IMPLEMENTAR Y PROBAR EL SISTEMA DE COMUNICACION Y
CONTROL

Sistema de control

Para el control de la silla de ruedas se disefid una tarjeta electrénica con
componentes basicos como el regulador de voltaje LM7805, que se usara
para poder alimentar la placa electronica con un voltaje regulado de 5
voltios, con una bateria de 9 voltios; ademas, se usa el integrado L293D,
que es un Driver con 4 controladores, disefiados para manejar relés,

solenoides, motores paso a paso, motores de corriente continua y
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bipolares, cada par de controladores forma un puente H-reversible
completo, con ello se puede controlar el sentido de giro de motores DC,;
en la figura 39 podemos ver el esquema de conexiones, segun hoja de

datos, las caracteristicas mas importantes del Driver son:

e Alimentacion de 4.5 a 36 VDC

e Corriente de salida 600 mA.

o Corriente pico de salida 1 A por canal.

e Encapsulado DIP de 16 pines.

e Alta inmunidad al ruido eléctrico.

e Proteccion contra exceso de temperatura.

e Diodos de proteccion incorporados.

g : veer (L6 VCC
DIR1A 2 A |15 DIR2A 3 3
OTiz ay |12 MOT2 R= Q.=
7 ccMoT 4
GND GND1 o3 |13 GND 5
GND 5 1 anp GNps |12 GND
L——+—C MOT1-2 _ . I
+ ,‘5{11{} - | 0 6 | oy 3y |1l MOT2R [
y ¥ ? B A - 10 IR2B -
0= = p 2 A —
oT ) I PN
Z; GHD j’i Ve ! Y
) ' 293D

Figura 39. Confecciones del driver L293D.

El control general del sistema electronico se realiza con el
microcontrolador Atmega328P, segun su hoja de datos sus caracteristicas
mas importantes son:

e Microcontrolador AVR de 8 bits de alto rendimiento y baja
potencia.

¢ Arquitectura RISC avanzada.

e 32 x 8 registros de proposito general.

e 32KB de memoria flash.

e 1 KB de EEPROM.

e 2 KB de SRAM interna.

¢ 10,000 ciclos de escritura y borrado de la memoria flash.

e 100,000 ciclos de escritura y borrado de la memoria EEPROM.
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separado y modo de comparacion.

2 temporizadores / contadores de 8 bits con preescalador

e Un temporizador / contador de 16 bits con preescalador separado,

modo de comparacion y captura.

e Contador en tiempo real con oscilador separado.

e 6 canales PWM.

e ADC de 6 canales y 10 bits.

e USART programable.

e |Interfaz SPI maestro/esclavo.

¢ |Interfaz serial de 2 hilos compatible con 12C.

e QOscilador interno de 8MHz.

e Oscilador externo hasta 20 MHz.

e Encapsulado PDIP de 28 pines.

e
ja R
N
L_ .
Iu_ ol 110 1 yraro
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Figura 40. Conexiones del microcontrolador ATmega328P.
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Con la finalidad de facilitar la programacion del microcontrolador, a través
del uso del entorno de desarrollo integrado (IDE) de Arduino, se usa un
Arduino programado como ISP (In-system programming) o comunmente
llamado ICSP (in-circuit serial programming) para grabar el Bootloader en
el microcontrolador, para ello se siguen las conexiones mostradas en la
figura 41, con ello es posible grabar a través del IDE de Arduino, el

Bootloader correspondiente al microcontrolador Atmega328P.

XTALY
“16 Mh;

.
ATmega 328P HHz
U
--.-.-M-.---l.l-.--

ZIZIZIZé: III_W_I

::::: :ﬁ... N L . « U

Figura 41. Conexiones para grabar el Bootloader al microcontrolador.

Teniendo el bootloader instalado en el microcontrolador, este ya puede
ser colocado en la placa electrénica disefada, la cual podemos ver en la

figura 42
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Figura 42. Placa electrénica de control.

Los algoritmos se pueden grabar a través de un conversor en este caso

usaremos el médulo CP2102, el cual es un conversor/grabador, que permite

la comunicacion entre un microcontrolador y una PC utilizando el puerto

USB, este médulo es compatible con cualquier microcontrolador como PIC,

AVR, entre otros. Sus caracteristicas mas importantes son:

USB 2.0 con velocidad de 12 Mbps.

Conector USB tipo A.

Transceiver USB integrado.

Cristal oscilador integrado.

Regulador de voltaje de 3.3V.

Buffer de recepcién de 576 Bytes.

Buffer de transmision de 640 Bytes.

Sistemas Operativos soportados: Windows 10, 8, Vista, 7, XP, 2000,
98SE y Linux 2.40(en adelante).

75



Cabe aclarar que la interfaz cerebro-maquina vine dada por la comunicacién
mediante Bluetooth entre la Cyton-board y su USB explicados en el capitulo
anterior, la este sistema capta las sefales, las cuales son recibidas por
Matlab, este realiza el procesamiento y envia instrucciones via Bluetooth a
la silla de ruedas, en otras palabras la Cyton-board se conecta a Matlab por
la interfaz cerebro-maquina y Matlab se conecta al circuito de la silla de
ruedas enviando instrucciones y por ende controlandolo, he ahi la relacion
entre la interfaz cerebro-maquina a y el circuito de control de la silla de

ruedas.
3.5.2. Sistema de comunicacioén

El mddulo de comunicacion usado para acoplar la silla de ruedas con el PC
es el modulo bluetooth HC-05, el cual ira conectado a la placa electronica, y
un adaptador Bluetooth tipo USB para la PC, luego de instalar los drivers
respectivos, desde la PC nos conectamos al modulo bluetooth de la silla de
ruedas, con ello logramos la conexiéon de ambos mddulos bluetooth. Para
enviar informacion desde el PC a la silla de ruedas se implementa un cédigo
en Matlab capas de enviar datos correspondientes a las direcciones

respectivas, con las cuales se controlara el movimiento de la silla de ruedas.

delete(instrfindall);
PS=serial('COM5','BaudRate',9600,'timeout',1);
flushinput(PS);

fopen(PS);

fwrite(PS,dir3);

fclose(PS)
delete(PS)
clear PS

con el cédigo delete(instrfindall) borramos el registro de todos los objetos
visibles y ocultos que se hayan creado para la communication serial. Con la
linea de cddigo PS=serial ('COMS','BaudRate’',9600,'timeout',1) creamos un
objeto de comunicacién serial en el puerto COM5, a una velocidad de
transmision de 9600 baudios y un tiempo maximo de ejecucion del comando

de 1 segundo. Con el cédigo flushinput(PS) borramos el buffer de

76



comunicacion, con la finalidad de que esté vacio y preparado para la
comunicacion con el modulo de la silla de ruedas. Con el codigo fopen(PS)
abrimos el puerto serial, con lo cual queda listo para enviar datos; para el
envio de datos usamos el codigo fwrite(PS,direccion), con lo cual logramos
enviar la direccion respectiva por el puesto serial que ya hemos creado
anteriormente. Finalmente con los codigos fclose(PS), delete(PS)y clear PS
cerramos, eliminamos y limpiamos respectivamente, todos los datos

correspondientes a la comunicacion serial.

En la parte de Arduino se implementd un cddigo capas de recibir, a través
de bluetooth, el dato correspondiente a la direccion, con el cual la tarjeta de
control se encarga de mover los motores en la direccién indicada por la PC.

En la figura 43 podemos ver el prototipo de silla de ruedas implementado.

Figura 43. Ensamblaje final del prototipo de silla de ruedas.

3.5.3. Pruebas y resultados del proyecto
Para probar el funcionamiento de la comunicacién se cred una interfaz
grafica, desde la cual es posible controlar la silla de ruedas de forma
inalambrica, una imagen de la interfaz grafica podemos verla en la figura

44, como podemos ver tenemos 6 botones 4 corresponden a las cuatro
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direcciones de movimiento de la silla de ruedas, los otros dos

corresponden a la conexion y desconexién de la comunicacion.

+ Ctrl_interface = © &5 ]
Boton de
Conexidn Control Interface

\! | Botones de
‘—

Direccion
Botdn de
By: Witman J. Alvarado Diaz Desconexion

Figura 44. Interfaz grafica de pruebas.

Para colocar imagenes de flechas en los botones, se realiza mediante el
siguiente cddigo, colocado en la funcion inicial de la interfaz grafica, se

establece el mismo cddigo para cargar y mostrar las otras imagenes.

[a,map]=imread('adelante.jpg");
[r,c,d]=size(a);

x=ceil(1/50);

y=ceil(c/50);
g=a(l:x:end,1:y:end,:);
g(g==255)=5.5*255;
set(handles.Front_button,'CData',g);

En la funcién correspondiente al botén conectar se establece un cédigo
capas de conectar el modulo bluetooth e iniciar la comunicacion para
enviar los datos hacia la silla de ruedas, codigo para lograr esto es el

siguiente.
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delete(instrfindall);
PS=serial('COMS5','BaudRate',9600,'timeout',1);
flushinput(PS);

fopen(PS);

handles.PS=PS;

guidata(hObject,handles);

los botones correspondientes a las direcciones envian a través del puerto
serial los cédigos explicados anteriormente, se envian con el comando
fwrite(PS,’1’), para que la silla de ruedas se mueva; finalmente el botén
desconectar cierra, elimina y limpia el puerto serial con los siguientes

cédigos.

fclose(PS)
delete(PS)
clear PS

los resultados de la clasificacion del proyecto, se muestran en una matriz
de confusion en la figura 45; una matriz de confusién permite observar el
desempeno de un algoritmo, en la matriz presentada, cada columna
representa el niumero de predicciones por cada clase, mientras que cada

fila representa la cantidad de observaciones para las clases reales.
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Clases verdaderas

1 2 3
Clases Predichas

Figura 45. Matriz de Confusién.

Donde: 1=lzquierda; 2=Adelante; 3 = Derecha y el color verde representa

la cantidad de aciertos lo demas son cantidad de fracasos.

Una matriz de confusion ayuda a observar y analizar si un algoritmo esta
confundiendo las clases, en la matriz de confusion generada podemos
observar que el sistema creado tiene errores, las zonas rojas son las
cantidades de veces que algoritmo se equivocé al predecir la clase a la
cual pertenecen los datos; las zonas pintadas de color verde, representa
a la cantidad de veces en la cual el sistema creado a acertado al predecir
la clase a la cual corresponden los datos.

De la matriz de confusidon podemos calcular el porcentaje de eficiencia,
que es la relacion del numero total de predicciones correctas con el total

de predicciones, calculamos la eficiencia con la siguiente formula.

Efici . Predicciones Correcta 100%
iciencia = *
Total de Predicciones 0
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Aplicando la formula a la matriz de confusidon generada obtenemos

. 60 + 57 + 62 L0
= *
e = 0 57 +62+4+3+4+2 0

Eficienci _ 1P 100%
iciencia = 7o * 0

Eficiencia = 93.23%

Con ello obtenemos que la eficiencia del sistema creado, que es de
93.23%, con lo cual se demuestra que el sistema planteado es
completamente funcional, y puede ser usado en personas con esclerosis
lateral amiotrofica o en personas con atrofias afines, que los conlleve a

usar silla de ruedas.
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CAPITULO IV: ASPECTOS ADMINISTRATIVOS
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41.

41.1.

41.2.

ANALISIS DE COSTOS

Recursos humanos

Para los recursos humanos se considera los pasos realizados para la
creacion del sistema, por ello se considerara los costos del desarrollo de

la programacion, fuentes bibliograficas y movilidad.

Tabla 22. Presupuesto de Recursos Humanos.

PRESUPUESTO DE RECURSOS HUMANOS

Desarrollo del Algoritmo. S/ 2,500.00
Fuentes Bibliograficas S/ 50.00
Mano de Obra S/ 1,000.00
Movilidad S/ 20.00
Costo Total 1 S/ 3,570.00

Recursos de hardware

Para desarrollar el algoritmo se necesita comprar una laptop, la cual se
encargara del procesamiento de todas las sefales, asi como también se
necesita el sistema OpenBCl y el casco Ultracortex para la ubicacion de

los electrodos.

También, se requiere materiales extras como por ejemplo pilas para la
alimentacion del sistema OpenBCl, un pegamiento para acoplar la silla de
ruedas, en la tabla 23 se indican los costos de los dispositivos necesarios

para la creacion del sistema inalambrico.
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Tabla 23. Presupuesto de Equipos.

PRESUPUESTO DE EQUIPOS

Cyton + Daysi Biosensing Boards S/ 4,079.63
Kit Ultracortex " Mark IV " S/ 4,109.96
Laptop Toshiva Core 15 S/ 1,500.00
Pilas AA Duracell S/ 20.90
Pila de 9v S/ 15.00
Componentes electrénicos varios S/ 40.00
Plastico PLA S/ 100.00
Costo Total 2 S/9,865.49

4.1.3. Recursos de software

Se considera la suscripcion al software utilizado para el procesamiento y
comparacion de las ondas cerebrales. No se le considera el software el
sistema OpenBCl porque viene incluido en los costos de compra
mostrados anteriormente. En la siguiente tabla presentamos el monto
anual del software MATLAB.

Tabla 24. Presupuesto de Programas.

PRESUPUESTO DE PROGRAMAS

Software MATLAB S/ 220.66
Software SolidWorks S/ 4,338.25
Costo Total 3 S/ 4,558.91

Considerando los costos totales de las tablas anteriores obtenemos la
inversion total de la creacion del sistema.
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4.2,

421.

Tabla 25. Tabla General de Costos.

SUMATORIA DE COSTOS

Costo Total 1 S/ 3,570.00
Costo Total 2 S/ 9,865.49
Costo Total 3 S/ 4,558.91
Monto Total S/ 17,994.40

ANALISIS DE SENSIBILIDAD

Desarrollo del flujo de caja

Para el flujo de caja usamos el monto total obtenido en la tabla 25, los
cuales son gastos por producto, ademas se considerara los costos
anuales de mantenimiento y de produccion del mismo sistema. En la tabla
26 se muestran los montos de ingresos y egresos, asi como también los

beneficios.

Se pretende vender anualmente 2 sistemas, por ello se tomara en cuenta
lainversién inicial para ambos sistemas, agregando una ganancia del 25%
de utilidad, obteniendo asi S/ 45586.56, lo cual representa el total de

ingresos.
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Tabla 26. Tabla del Flujo de Caja.

ANO 0 1 2 3 4 5

INGRESOS

COSTO UNITARIO S/.17,994.40 S/.17,994.40 S/.17,994.40 S/.17,994.40 S/.17,994.40

TOTAL, INGRESOS S/.44,986.00 S/.44,986.00 S/.44,986.00 S/.44,986.00 S/.44,986.00
EGRESOS

INVERSION INICIAL S/.  35,988.80

GASTOS POR RECURSOS

HUMANOS S/.  3,570.00

GATOS POR HARDWARE S/.  9,865.49

GASTOS POR SOFTWARE S/. 455891 S/. 455891 S/. 4,55891 S/. 455891 S/. 4,658.91 S/. 4,558.91

MANTENIMIENTO S/. 4,000.00 S/. 4,000.00 S/. 4,000.00 S/. 4,000.00 S/. 4,000.00

PRODUCCION S/. 35,988.80 S/. 35,988.80 S/. 35,988.80 S/. 35,988.80

TOTAL, DE EGRESOS S/. 35,988.80 S/. 8,558.91 S/. 44,647.71 S/. 44,547.71 S/. 44,547.71 S/. 44,547.71

FLUJO DE CAJA S/. -35,988.80 S/. 36,427.09 S/. 438.29 S/. 438.29 9. 438.29 S/. 438.29

COSTO BENEFICIO S/. -35,988.80 S. 438.29 S/. 876.58 S/. 1,314.87 S/. 1,753.16 S/. 2,191.45
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42.2.

4.2.3.

Analisis del VAN

Para el analisis del valor actual neto (VAN), se toma en cuenta el valor
de la inversidn inicial para los 2 dispositivos que es de S/. 35,988.80; se
estima una tasa de descuento del 10% para un periodo de 5 anos
posterior a la implementacién del sistema. Como se observa en el flujo
de caja, a partir del primer afo ya se obtiene un beneficio, el cual va en

aumento a lo largo del tiempo.
Para halar el VAN se usa la Ecuacién 1

F2 Fn

VAN = it @ ————1o (1)

Donde:

F1, F2 ... Fn = Montos del flujo de caja.

i = Es la tasa de Descuento.

n = Numero de términos que se esta analizando.
lo = Inversion inicial.

Utilizando la formula, obtuvimos un VAN positivo de S/.34,524.94, de

esta manera podemos observar que la inversion es rentable.

Analisis del TIR

La Tasa Interna de Retorno (TIR), indica el porcentaje de viabilidad del
proyecto, determinando la rentabilidad de la inversion inicial, para este

analisis de uso la Ecuacion 2.

L P2 Fn
(1+TIR)' " (1+TIRZ ™™ (1+ TIR)™

Io=0 )

Donde:

F1, F2 ... Fn = Montos del flujo de caja.

n = Numero de términos que se esta analizando.
lo = Inversion inicial.
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424,

Operando la formula se obtiene como resultado un TIR de 5%, lo cual

nos indica la rentabilidad del proyecto.

Analisis del ROI

El analisis del ROl o como sus siglas en inglés Return On Investment, el
cual se define como el valor econdmico generado de la relacion entre

inversion y beneficios; con la Ecuacion 3 podremos determinar ROI.
(Beneficio — Inversion)

ROI = 100 3
Inversion * ®3)

Realizando la operacion se obtiene un resultado de 1%, que indica el
nivel de retorno de la inversion, que en este caso es positiva indicando

la rentabilidad del proyecto.
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Conclusiones

Se concluye que ELA es una enfermedad que afecta a 337 personas en
total en todo el Peru, de los cuales 212 estan en lima lo cual representa el
63% de los casos; del total de personas el 49% de los casos los pacientes
tienen entre 30 y 59 anos, y un 41% de los casos tiene 60 afios.

Se logré la comunicacion entre la Cyton Board con Matlab, gracias a
librerias en Python, y a herramientas desarrolladas en Matlab; las cuales
estan disponibles en linea para cualquier persona.

De igual manera, reconocer las senales electroencefalograficas, ademas
se pudo ver las diferencias que existe entre los datos correspondientes a
la imaginacion del movimiento de los brazos derecho e izquierdo; también
se logré extraer caracteristicas esenciales de las sefiales, con la ayuda
de la transformada rapida de Fourier.

Ademas de disenar un prototipo de silla de ruedas, el cual ha sido probado
y demostrado su 6ptimo funcionamiento, todo el disefio se desarrollo
integramente en el software Solidworks, como un modelo para ser
impreso en 3D.

Con las pruebas se demostré que el funcionamiento del sistema es
adecuado y optimo, ademas se logré controlar la silla de ruedas con un
porcentaje de eficiencia aproximado del 93%, con lo cual queda
demostrado que el sistema planteado funciona y cumplen con el objetivo
general de este trabajo de desarrollar una interfaz cerebro-maquina para
controlar una silla de ruedas a través del procesamiento y clasificacién de
senales electroencefalograficas usando Matlab; con la finalidad que un
paciente de ELA tenga independencia parcial al trasladarse con su silla

de ruedas.
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Recomendaciones

Se recomienda a las personas que fueron miembros de |la asociacién ELA
Peru, la reactivacion de la misma, ademas de crear un programa de
voluntariado para reforzar las instituciones enfocadas en ELA.

En segundo lugar, se recomienda al Ministerio de Salud del Peru, la
Integracién de pacientes con ELA al sistema integral de salud, ya que
mantener a un paciente con esta enfermedad es muy costosos.
También, se recomienda a la comunidad cientifica explorar las opciones
de configuracion de la Cyton Board; por ejemplo, su acelerometro, y de
esta forma poder usar toda la capacidad que este dispositivo posee.

Por ultimo, se recomienda a la comunidad cientifica, realizar la creacién
de una interfaz sencilla en el lenguaje Python; ya que, las librerias
principales estan escritas en este lenguaje; esto facilitaria y mejoraria la

recepcion de datos.
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Glosario

Atrofia muscular: Término médico que se refiere a la disminucion del tamafio
del musculo, perdiendo fuerza este debido a la relacidon con su masa. Afecta a
las células nerviosas de los musculos esqueléticos, generando paralisis. La

paralisis puede ser parcial o completa y generalmente comienza insidiosamente.

Insuficiencia respiratoria: Es un sindrome clinico que se caracteriza por la
incapacidad del organismo para mantener los niveles arteriales de oxigeno (02)
y didxido de carbono (CO2) adecuados para las demandas del metabolismo

celular.

Interfaz cerebro-maquina: Las interfaces neuronales directas (IND) interfaces
cerebro-computador (también interfaz cerebro-computadora e interfaz cerebro-
ordenador, en inglés Brain Computer Interfaces (BCl), constituyen una
tecnologia que se basa en la adquisicion de ondas cerebrales para luego ser

procesadas e interpretadas por una maquina.

Esclerosis Lateral Amiotréfica (ELA): Enfermedad degenerativa que afecta
principalmente a las extremidades laterales, con el fin de quitar el funcionamiento

completo de ellos.

Sistema OpenBClIl: Dispositivo detector de ondas cerebrales que actua
directamente con los impulsos eléctricos cerebrales para asi reconstruir la onda

cerebral con 16 canales colocados alrededor de la cabeza.

Ondas Cerebrales: Son la creacién de los impulsos eléctricos cerebrales, estos
impulsos estan siempre en constante uso debido a que el cerebro nunca cesa,

facilitando su estudio.
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ANEXO 1: Diagrama de Gantt

VNornbre de tarea ‘Duracién romienzo VFin
2019
T2 l 13 T4 T1 12
IMPLEMENTACION DE UNA INTERFAZ CEREBRO- Mf\QUINA PARA EL CONTROL DE 336 dias mié 20/06/18 mié 22/05/19 L . v
UNA SILLA DE RUEDAS
INICIO 0 dias mié 20/06/18  mié 20/06/18 20/06
Analisis de la situacidn actual de los pacientes con ELA 38 dias mié 20/06/18 vie 27/07/18 L‘
ELA en el mundo 6 dias mié 20/06/18  lun 25/06/18 20/06  25/06
ELA en el Peru 7 dias mar 26/06/18 lun 02/07/18 26/06 55 02/07
 Asociacién ELA Pert 7dias  mar03/07/18 lun 09/07/18 03/07 % 09/07
Asociacién Hecho con amor 8 dias mar 10/07/18 |mar 17/07/18 10/07 ‘--‘ 17/07
Datos estadisticos 10dias  mié 18/07/18 \vie 27/07/18 18/07 &y 27/07
Caracteristicas técnicas 60 dias lun 30/07/18 jue 27/09/18 e
Conexién de la cyton board al PC 15 dias lun 30/07/18  lun 13/08/18 30/07 mmm 13/08
Transmission por lab streaming layer 15 dias mar 14/08/18 |mar 28/08/18 14/08 28/08
Recepcion de las sefiales 30 dias mié 29/08/18 jue 27/09/18 29/08 27/09
Procesamiento de las sefales EEG 66 dias lun 01/10/18 mié 05/12/18 P———
Pre procesamiento 15 dias lun 01/10/18  lun 15/10/18 01/10 mum 15/10
Extraccién de caracteristicas 21 dias mar 16/10/18 lun 05/11/18 16/10 L 05/11
Clasificacién 30 dias mar 06/11/18 mié 05/12/18 06/11 05/12
Diseiio de un prototipo de silla de ruedas 45 dias lun 07/01/19 mié 20/02/19 P—
Disefio de estructura 15 dias lun 07/01/19  lun 21/01/19 07/01 pum 21/01
Disefio de llantas 15 dias mar 22/01/19 |mar 05/02/19 22/01 gy 05/02
Disefio de acoples 15 dias mié 06/02/19 |mié 20/02/19 06/02 Fgy 20/02
Implementar y probar el sistema de alimentacion y control 90 dias jue 21/02/19 mar 21/05/19 P——
Sistema de control 30 dias jue 21/02/19  vie 22/03/19 21/02 mmmmm 22/03
sistema de comunicacidn 30 dias sab 23/03/19 |dom 21/04/19 23/03 T 21/04
Pruebas y resultados del proyecto 30 dias lun 22/04/19  |mar 21/05/19 22/04 21/05
FIN 0 dias mié 22/05/19  mié 22/05/19 & 22/05
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ANEXO 2: Matriz de consistencia

A PREGUNTA DE PREGUNTA DE OBJETIVOS A
PROBLEMATICA INVESTIGACION OBJETIVO GENERAL INVESTIGACION ESPECIFICOS ACCIONES MARCO TEORICO DESARROLLO CONCLUSIONES RECOMENDACIONES
Se concluye que, el ELA
Una de las es una enfermedad que
enfermedades que Estqdio del ELA en el Asocia}ciones de ELA en | afecta a 337 personas en Se recomienda reactivar
degeneran las neuronas Peru y el mundo. el Peru y el mundo. total en todo el Per’u, de la asociacién ELA Pert.
es la esclerosis lateral ¢Cudl es la situacion | Analizar la situacion :98 cluales|212 estan er} ademas de hacer un
amiotréfica (ELA), la cual actual de los pacientes | actual de los pacientes érgs odcu? represer?tadel programa de
afecta  al  sistema de ELA? con ELA. ot T q e 1os casosl, 493 voluntariado para
nervioso central, lo que Buscar datos Analizar los  datos doa le personas € I ° | reforzar las instituciones
conlleva a una paralisis estadisticos del ELA en estadisticos de ELA en|2S 105 08805 1081 ¢ cadas en ELA
general de manera ol Pert Perd pacientes tienen entre 30
progresiva, por lo que, ' ' y 59 afios, y un 41% de
tiene un  prondstico los casos tiene 60 afos.
mortal. ¢ Cuales son los Los requisitos
. Conexion de al Cyton necesarios L
Los pacientes  que parametros y Board. principalmente son | S€ logro la comunicacién _
padecen de esclerosos caracteristicas aplicaciones de software. | €ntre la Cyton Board con | Se  recomienda ~ la
lateral amiotréfica. con el . Conocer los . Las librerias necesarias Matlab, gracias a | Integracién de pacientes
0aso del ,tiempo necesarias para la requerimientos técnicos Transrmswn por Lab para Python como Iibreria§ en Python, y a con ELA al sistema
necesitan que terceras implementacion de una | Necesarios  para el | Streaming Layer. numpy, pylsl, etc. herramientas integral de salud, ya que
personas los ayuden a Implementar una interfaz | desarrollo de gnalnterfaz : : desarrolladas en Matlab, | mantener a un paciente
desplazarse, ya que ellos cerebro-maquina  para interfaz cerebro- | cerebro-maquina Esclerosis lateral | o i los  toolbox | @S cudles  estan | con esta enfermedad es
no pueden moverse, por controlar una silla de | maquina? Recepcion por Matlab. aom|otrof|ca. como BCILAB, ERPLAB, dlspon!bles en linea para | muy costosos.
. . ndas Cerebrales. cualquier persona.
ello necesitaran usar una ruedas a través del Transformada répida de EEGLAB, etc
silla de ruedas, | ,Como lograr que los | procesamiento y Fourier
ocasionando que la|pacientes con ELA|clasificacion de sefiales Sistemé open BCI Se logro reconocer las
calidad de vida del|puedan controlar su silla | electroencefalograficas Matlab P ' sefiales
paciente se vea |de ruedas usando su|usando algoritmos y las . ~ S Se aplican filtros pasa | electroencefalograficas,
disminuida. Para evitar la | cerebro, el cual aun en | herramientas de Matlab; Filtrar las sefiales. Prgc?samlento de las banda ademas se pudqo ver las
dependencia, se puede | funcional? de tal forma que le SE?(rt]raaggi'én de diferencias que existe
usar las sefales permita a un paciente de caracteristicas entre los datos
cerebrales del paciente ELA tener independencia o . correspondientes a la . -
con la finalidad de parcial al trasladarse con ;Cémo diferenciar o P | Aal g:;saeggfig;ztotlpodela Se teristi extraenl imaginzcién del Reallzlar urt1a l.ca”?E’a”a
disefiar una interfaz su silla de ruedas. interpretar las sefiales de lrocesar fals s?na ©5 | Extraer caracteristicas. ' carac ‘ZF'S |cas|conjq | movimiento de  los |P2r@ '@ acdua lzacion y
cerebro-maquina que le |a actividad cerebral? electroencefalograficas. prclnme io y el maximo| .- o derecho o regl_stro e nuevos
permita sentirse con valor. izquierdo, también se pacientes.
mayor libertad, ya que logro extraer
podra des.plazarse por caracteristicas
sus  propios medlos, - . Se aplica el analisis de | esenciales de las
mejorando su calidad de Clasificar las sefiales. discriminante lineal. sefiales, con la ayuda de
vida y aportando la transformada rapida
parcialmente a su de Fourier.
indepgndencia. Cabe Se logro disefiar un
mepcuinard quA el prototipo de silla de
aciente de no . i
Eierde su capacidad ¢Con que silla de ruedas gﬁgZZB ely nglmr:)astrsalgg Explorar las opciones de

cerebral en el transcurso
de la enfermedad, ya que
esta, solo afecta a las
partes que les brindan
movimiento a los
musculos.

se puede probar el

sistema?

Disefiar un prototipo de
silla de ruedas a escala.

Disefio de la estructura
necesaria para la silla de
ruedas.

Se disefio, imprime en
3D, y se ensambla el
prototipo de la silla de
ruedas.

su optimo
funcionamiento, todo el
disefio se desarrollo
integramente en el
software Solidworks,
como un modelo para ser
impreso en 3D.

configuracion de la Cyton
Board por ejemplo su
acelerometro, y usar
toda la capacidad que
este dispositivo posee.
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¢, Cémo validar
funcionamiento
sistema?

el
del

Implementar y probar el
sistema de comunicacion
y control.

Conectar la silla de
ruedas y el pc mediante
bluetooth.

Controlar
ruedas,
bluetooth.

la silla de
mediante

Con las pruebas se
demostré que el
funcionamiento del
sistema es adecuado y
optimo, ademas se logro
controlar la silla de
ruedas con un porcentaje
de eficiencia aproximado
del 93%.

Realizar todo el
procesamiento en
Python, ya que Ilas
librerias principales
estan escritas en Python,
esto facilitaria y

mejoraria la recepcion de
datos.
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ANEXO 3: Protocolo de Utilizaciéon

El protocolo de utilizacion es el siguiente:

1. La adquisicion de datos se desarrolla en el lugar cerrado, sin perturbaciones
ambientales.

2. Al paciente, se le deja unos minutos para que se relaje, ya que para obtener
mejores resultados el paciente debe estar en un estado de calma.

3. Se coloca un casco con electrodos conectados a un circuito electrénico, este
casco se le posicionara en la cabeza del paciente se fijaran los electrodos en
el cuero cabelludo asegurandose que haya un buen contacto.

4. Luego se procede a ejecutar el algoritmo de obtencién de datos el cual muestra
3 direcciones aleatorias, representadas por flechas, por un tiempo de 9
segundos cada una, de los cuales 7 segundos se muestra la flecha y 3
segundos no se muestra nada, todo ello por 64 repeticiones cada direccion.

5. Con cada flecha el paciente imaginara mover el brazo correspondiente, para
las flechas derecha, izquierda, y adelante, se debe imaginar el movimiento de
los brazos izquierdo, derecho y ambos respectivamente.

6. Luego de obtenidas todas las senales, estas pasan a etapa de pre
procesamiento, extraccion de caracteristicas y clasificacion.

7. Luego de la clasificacion, ya se sabra cual es la direccién correspondiente para
cada sefal, asi que el algoritmo brinda una funcion matematica para realizar
las predicciones.

8. Se pasa a una etapa de pruebas donde, se extraen datos y se aplica la funcion
matematica del paso anterior, el resultado es interpretado y enviado a la placa
de control de la silla de ruedas.

9. La placa de control recibe la sefial enviada desde Matlab y realiza el movimiento

respetivo.

100



ANEXO 4: Datos Estadisticos

Primeramente debemos conocer la poblacion con la que se realizo la investigacion, la
cual consistio en elegir personas sanas, de los cuales se obtendran los casos vy
controles; cada poblacion esta conformada por 5 individuos ya que en (lturrate et al.,

2009) se menciona que es suficiente para validad este tipo de proyectos.

Las senales generadas por los casos son el 100% correctas ya que se obtiene con la
herramienta de adquisicion de sefales disefiada por tal motivo ya se tiene
conocimiento de la correspondencia de la sefial con la direccidén especifica a la cual
representa, estas sefales son procesadas y luego de ello se prueba el algoritmo en
los controles de los cuales se obtuvieron datos relevantes para identificar el porcentaje

de funcionalidad del sistema; tener en cuenta que se realizé 64 pruebas por cada

direccion.
CASOS
Paciente Acerto No acerto Porcentaje
Izquierda | Derecha | Adelante | Izquierda | Derecha | Adelante
1 64 64 64 0 0 0 100
2 64 64 64 0 0 0 100
3 64 64 64 0 0 0 100
4 64 64 64 0 0 0 100
5 64 64 64 0 0 0 100

Tabla 1: Datos de la cantidad de aciertos de las personas del grupo de casos
Fuente: Elaboracién Propia.

CONTROLES
Paciente Acerto No acerto Porcentaje
Izquierda | Derecha | Adelante | Izquierda | Derecha | Adelante
1 57 55 60 7 9 4 89.58
2 55 55 59 9 9 5 88.02
3 59 60 58 5 4 6 92.19
4 60 62 57 4 2 7 93.23
5 58 60 60 6 4 4 92.71

Tabla 2: Datos de la cantidad de aciertos de las personas del grupo de controles
Fuente: Elaboracién Propia.

Con estos datos queda demostrado el funcionamiento del algoritmo planteado en la
presente tesis, asi como también se demuestra que su uso es adecuado para el
control de una silla de ruedas. Ya que se obtuvo porcentajes de aciertos mayores al

90%, lo cual significa que el sistema es eficiente.
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